
Acknowledgments

This microcomputer program is an enhanced version of an original Portland Cement
Association mainframe program written by K. M. Kripanarayanan. Many of the
original and fundamental algorithms are present in much of this microcomputer
version.

Additional enhancements, the manual and software design, and microcomputer
programming were created and performed by the Computer Programs Marketing
Department of the Portland Cement Association.

While the Portland Cement Association has taken every precaution to utilize the
existing state of the art and to assure the correctness of the analytical solutions and
design techniques used in this program, the responsibilities for modeling the
structure, inputting data, applying engineering judgement to evaluate the output, and
implementing engineering drawings remain with the structural engineer of record.
Accordingly, Portland Cement Association does and must disclaim any and all
responsibility for defects or failures of structures in connection with which this
program is used.

© 1999 Portland Cement Association.   All rights reserved.

MS-DOS is a trademark of Microsoft, Inc.
Microsoft and Windows are registered trademarks of the Microsoft Corporation.



ADOSS Features

ADOSS, the microcomputer version of PCA’s mainframe program-Analysis and
Design of Slab Systems (ADOSS), analyzes and designs an interior or exterior two-
dimensional equivalent frame according to the relevant provisions of the Code.
ADOSS provides the following three options: the Strength Design Method, the
Limit States Method, and the Alternate Design Method. The program handles both
round and rectangular columns, while allowing for user-controlled fixity conditions
of all supports. The height of each column may differ, and the slab depth may vary
from span to span.  Lateral loads may be input into the program either as
concentrated story loads, or as joint moments from STMFR II (PCA’s frame analysis
program) or from any other analysis program. The output includes the analysis of
centerline and design moments and shears, punching shear stresses, cracked section
deflection, and torsion design of transverse beams.  Based on a realistic selection of
reinforcement and bar lengths, the program provides a quantity estimate for
concrete, reinforcement, and formwork.

Model elements and vertical loads acceptable to ADOSS

1 The Code refers to either the ACI 318-95 Code, or the CSA Standard A23.3-94.
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Chapter 1

Installing the Program

Installing ADOSS

1. Execute Windows and insert the ADOSS diskette into the proper floppy
disk drive.

2. From the Program Manager File menus, select Run.

3. Enter a:pcasetup or b:pcasetup (depending on the drive the
diskette is in) in the COMMAND LINE text box, then choose OK.

4. The setup program prompts you for the directory where ADOSS is to be
installed.  The default directory is C:\ADOSS.  To specify and alternate
directory, type in the directory complete with a drive letter.  If the
directory does not exist, the setup program creates it.  Press ENTER or
choose INSTALL.

5. The DEFAULT OPTIONS dialog box appears next.  This allows you to
customize ADOSS by setting the units of measure (US or Metric) and the
Code (ACI or CSA).  These defaults are saved in the PCAPROGS.INI
file, located in the WINDOWS directory.

6. The CUSTOMER INFORMATION dialog box appears next asking for the firm
name, city, and state.  Be sure to press TAB to move to the CITY and STATE

text boxes.  Press ENTER or choose OK when done.

7. The setup program begins to copy files from the installation drive to the
destination drive.  Once the file transfer is done, setup adds the
“ADDOSS” icon to the Program Manager.  A “PCA Programs” group
box is created (if one does not exist) and the “ADOSS” icon is added.

8. After the setup program displays a successful installation message, the
last dialog box displayed ask whether you would like to view the
README.TXT file.  This file contains information supplemental to the
manual.
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Running ADOSS

To execute ADOSS from within Windows:

• Select the “ADOSS” icon from within the “PCA Programs” group window
and press ENTER (or simply double-click on the icon).

To execute ADOSS from the DOS prompt:

• Change the directory to where the program is installed, type in ADOSS and 
press ENTER.  This will execute Windows and load the ADOSS program 
as the application program.

System Requirements

To use ADOSS, a personal computer with the following hardware and software
configuration is needed.

• MS-DOS operating system version 5.0 or higher.

• Microsoft Windows version 3.1 (running in Enhanced mode).

Minimum requirements:

• 4.0 MB of RAM memory with 1 M of free conventional memory.

• One floppy disk drive.

• A hard disk with at least 2.0 MB of free space.

• A monitor supported by Windows V3.1.

• A mouse or other pointing device supported by Windows V3.1.

Recommended Options:

• A printer supported by Windows V3.1

• A math co-processor.
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Backing up the Original ADOSS Set 

Before you install ADOSS, take time out to make a backup copy of the ADOSS disk.
The license agreement states that you are allowed to make one backup copy of the
disk.  This backup set should be safely stored away and used only if the original disk
is damaged in any way. 

IMPORTANT: The license agreement states that only one backup could be made.
This set is strictly a backup copy and it is not intended to be used on any other
machine. 

Default Options Dialog Box

This dialog box allows you to customize ADOSS to your needs by setting two
default options; units of measure (US or SI) and code (ACI or CSA).  This will
eliminate the task of specifying these options for each ADOSS session. 

These defaults are saved in the file PCAPROGS.INI located in the Windows
directory.  Each time ADOSS is executed, PCAPROGS.INI is read by ADOSS and
the information is incorporated in the session.  You can also change these settings in
ADOSS by using the Default Unit/Codes command of the Options menu.

Note:  Selecting  Cancel will set the units and code options to the default values.
The default values are initially set to US units and ACI code.

Setting the Default Data Directory

PCA Setup will prompt you for the default data directory.  The default data directory
is the directory where ADOSS will look for data when you elect to open a data file.
The ADOSS default data directory is <ADOSS Directory>\DATA.  Figure 1-1
displays the default data directory dialog box.
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Figure 1-1  Default Data Directory dialog box

To use the default directory, press  Enter or select  Ok  .  If the data directory does
not exist, it will be created.  The default data directory will be written to the
PCAPROGS.INI file.  You can change the default data directory in ADOSS by using
the Default Data Directory command from the Options menu.

A different directory can be used for the data other than that given.  Use the
backspace key and enter the new directory where you want ADOSS to look for data.
If this directory does not exist, it will be created.  

Note:  Selecting Cancel will leave the default data directory unspecified.  This
approach is practical to the user who has multiple data directories and who does
not want to specify a particular data directory.  If the default data directory is left
unspecified, ADOSS assumes the current directory as the default data directory.  
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Customer Information

Record your firm name, city, and state.  Be sure to tab to the city and state edit boxes
instead of pressing enter.  By selecting  Ok or pressing  Enter , you are confirming
your choices.  By selecting  Cancel , changes made to this dialog box will not be
saved.

If you select  Enter a customer information verification box will be displayed
prompting you to confirm your choices.  Select  Enter to save the information or
select  Change if you want to edit the information displayed.

Note: Press  Enter only after all the edit boxes are filled in.

File Transfer and Change Disk Dialog Boxes

PCA Setup will begin to copy files from the drive the ADOSS Disk was placed in
to the ADOSS Directory.  The source path and destination path are displayed in this
dialog box along with a file transfer progress scale.  

View README Document

After PCA Setup displays a successful installation message, the last dialog box
displayed will ask whether you would like to view the ADOSS README file. 

This is a good opportunity to read this file which contains information supplemental
to the manual.  Selecting   Yes , will cause PCA Setup to execute the viewing
utility, PCA View, and load the README file.  Selecting  No will simply terminate
the PCA Setup program. 

IMPORTANT: A message box will appear acknowledging a successful installation
of ADOSS V7.00. If PCA Setup modified the AUTOEXEC.BAT file, reboot your
system in order for the changes made to the AUTOEXEC.BAT file to take effect.  If
PCA Setup did not modify the AUTOEXEC.BAT file, then you are ready to run
ADOSS V7.00. 
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Running ADOSS

There are a number of ways to execute ADOSS from within Windows.  One way is
to select the ADOSS Icon in the “PCA Programs” group window from within the
Program Manager and press  Enter .  Another way is to select the Run command
under the File menu in the Program Manager.  A dialog box will be displayed
prompting for a command line.  Type “ADOSS” in the edit box and press  Enter .
Lastly, you can execute ADOSS from the File Manager by selecting an ADOSS data
file with an .ADS extension and pressing  Enter .  PCA Setup creates this
application association between the application program, ADOSS, and the data files
which have the .ADS extension.
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Chapter 2

Method of Solution

The user should be aware of the assumptions made by the program during the
design stage. These include details regarding loading, strip widths, reinforcement
selection, deflection computations, material quantities, etc.

Geometric Checks

The ADOSS program provides geometric to avoid an analysis with an inconsistent
system.  The dimensions of the slabs, drops, and column capitals are checked and
modified to produce a legitimate system.

If the slab cantilever length is less than one-half the column dimension in the
direction of analysis c1, or less than the extension of the transverse beam into the
cantilever, the cantilever length will be increased to the larger of these two lengths.
If the slab width is less than one-half the column dimension transverse to the
direction of analysis, c2, or less than one-half the longitudinal beam width, the slab
width will be increased to the larger of these two widths.

If the drop panel lengths extend beyond the end of the slab cantilevers, the drop
panel lengths will be reduced so that they extend only to the cantilever tip.  The drop
panel will be shifted forward or backward in the transverse direction when the slab
strip width on either side of the column is less than one-half the drop panel width.

If a column capital contains an extension/depth ratio greater than 1, the extension
will be set equal to the capital depth.  If, by drawing lines extending the column
capital through the drop or beam to the underside of the slab, the column capital
extension falls outside the edge of the drop or beam at the slab soffit, the extension
will be modified such that these lines extend only up to the edge of the drop or beam
at the slab soffit (Figure 2-1).
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Figure 2-1  Maximum capital width

Code Checks

Prior to an analysis, ADOSS checks that the input values for the drop panel
dimensions, column capital dimensions, T-beam flange widths, waffle slab rib
dimensions, and slab and beam depths meet the applicable code values.

Drop Panel Dimensions

A valid ACI 318 drop must extend in each direction at least one-sixth the
center-to-center span length in that direction and have a drop depth below the slab
of at least one-quarter the input slab depth (Figure 2-2).  ACI slabs that contain valid
drops are allowed a 10% decrease in minimum slab depth.1 The drop depth of an
invalid drop will not be used in the calculation of the depth used to reduce the
amount of reinforcement required at a column,2 and will not be used in the
calculation of moment of inertia for deflection computations.

For CSA A23.2 drop panels, the extension of the drop panel beyond the edge of the
column or column capital is limited to one quarter of the clear span.  No minimum
is specified for this dimension.  The maximum depth of the drop panel below the
slab is limited to the input slab depth.
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Figure 2-2  Valid drop dimensions

Figure 2-3  Excess drop depth
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If the valid drop depth is greater than one-quarter the distance from the edge of the
drop panel to the face of the column or column the excess depth will not be
considered in the calculation of the effective depth used to reduce the amount of
reinforcement required at a column (Figure 2-3).3

The input drop dimensions will be used for self-weight computations, when
computing slab stiffness and to determine moments and shears when computing
punching shear around a column.

Column Capital Dimensions

If a column capital contains an extension/depth ratio greater than 1, the extension
will be set equal to the capital depth.  If, by drawing lines extending the column
capital through the drop or beam to the underside of the slab, the column capital
extension falls outside the edge of the drop or beam at the slab soffit, the extension
will be modified such that these lines extend only up to the edge of the drop or beam
at the slab soffit (Figure 2-1).

The modified column capital dimensions will be used when computing column
stiffness.

T-Beam Dimensions

For the ACI Code the effective T-beam flange width will not exceed one-quarter the
beam span length for the ACI code.  For beams that have slabs on both sides, the
maximum flange overhang will not exceed eight times the slab thickness or the input
slab width on that side.  For beams that have slab on one side only, the maximum
flange overhang will not exceed one-twelfth the beam span length, six times the slab
thickness, or the input slab width on the overhang side (Figure 2-4)4

For the CSA Standard the effective flange width of T-beams is based on the
overhanging flange widths on each side of the web which are not greater than 1/10
of the span length, 12 times the slab thickness or 1/2 the clear distance to the next
web.  Where a slab exists on only one side of the beam, the overhanging flange
width is limited to 1/12 of the span of the beam, 6 times the slab thickness, and 1/2
the clear distance to the next web.
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These T-beam dimensions will be used for computing the stiffness.  The entire slab
width, however, will be used when computing self-weight and superimposed surface
dead and live loads.

Waffle Rib Dimensions

Waffle slab rib dimensions will be considered valid if the rib width is at least 4 in.,
the depth is no more than 3-1/2 times the rib width, and the clear spacing between
ribs does not exceed 30 in. (Figure 2-5).  When valid ribs exist, the ACI code permits
the nominal concrete shear strength, Vc, to be increased by 10%.5

Figure 2-4  Allowable T-beam flange widths
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Figure 2-5  Valid rib dimensions

Minimum Slab Thickness of Flat Plate, Flat Slab and Beam-
Supported Slab Systems

For ACI 318-95 Code, the minimum thickness of slabs with or without interior
beams spanning between supports and having a ratio of long to short span not
exceeding 2 is:6

Eq. 2-1

but not less than

Eq. 2-2

For CSA A23.3-94

l   (0.8 +              )
36 + 9ß

200,000
h = am > 2.0

n
fy

l   (0.8 +              )
36 + 5ß (α   – 0.2)

200,000
h = 0.2 < am ≤ 2.0

n
fy

m
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where

ln = clear span in the direction of analysis.

ß = ratio of the clear spans in long to short direction.

am = average value of a, the ratio of flexural stiffness of a beam
section to the flexural stiffness of a width of slab bounded
laterally by centerlines of adjacent panels on either side of
the beam, for all beams supporting the edges of a slab panel.

For the design of ACI slabs without beams spanning between supports the minimum
thickness shall conform to ACI 318 Table 9.5(c)  For flat slabs that contain valid
drops, Table 9.5 (c) reduces the minimum thickness by approximately 10%.7 (See
Figure 2-2).

The minimum depth in a span that contains a discontinuous edge will be increased
by 10% if the edge beam provided has a stiffness ratio, a, of less than 0.80.8 The
first and last spans are considered to contain a discontinuous edge as well as a span
that contains an exterior edge.

For the CSA Standard the minimum thickness is:

a) for flat plates and slabs with column capitals

hs > ln (0.6 + fy /1000)/30

b) for slabs with drop panels

Eq. 2-3

where Xd / (ln/2) is the smaller of the values determined in the two
directions, Xd shall not be taken greater than ln/4 and hd - hs shall not be
greater than hs.

30 [1+ (   )(      )]

l   (0.6 + f  /1000)
h ≥

n

l  n

s h  –d2xd hs

hs

y
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For flat plate systems, the minimum allowable thickness can in no case be less than
5.0 in.  For two-way flat slab systems with drops, described above, the minimum
allowable thickness can in no case be less than 4.0 in., otherwise 5.0 in.9 For
supported slab systems supported by beams with an am greater than or equal to 2.0,
the minimum allowable thickness can in no case be less than 3.5 in., otherwise 5.0 in.10

is taken on the minimum allowable thickness.

A message will be printed with the output showing the required slab depth for any
span where the depth does not meet or exceed code requirements.

Minimum Thickness for Waffle Slab Systems

The minimum slab thickness allowed for waffle slabs is one-twelfth the clear rib
spacing, or 2 in.11

A message will be printed with the output showing the required slab depth for the
system if the depth does not meet or exceed code requirements.

Minimum Thickness of Continuous Beams and 
One-Way Slab Systems

The minimum depth of continuous beam systems and one-way slabs, made of
normal weight concrete and using Grade 60 reinforcing bars below which
deflections must be computed is shown in Table 2.1.12 Note: l in Table 2.1 is
center-to-center span lengths for ACI 318 and clear span lengths for CSA-A23.3.

For concrete density in the range of 90–120 pcf, the above minimum thicknesses are
increase by (1.65–0.005w) but not less than 1.09, where w is the concrete density in
pcf.  For fy other than 60 ksi, the minimum thicknesses are increased 
by (0.4 +fy/100).13

A message will be printed with the output showing the required beam or slab depth
for any span where the depth does not meet or exceed code requirements.
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Table 2.1 – Minimum Thickness of Continuous Beam and
One-Way Slab Systems

Special Considerations for Waffle Slabs

For the purposes of analysis and design, ADOSS replaces the waffle with solid slabs
of equivalent moment of inertia, weight, and punching shear resistance.

The equivalent thickness based on system weight is used to compute the system
self-weight.  This thickness, hw, is given by:

Eq. 2-4

where

Vmod = the volume of one waffle module.

Amod = the plan area of one waffle module.

The equivalent thickness based on moment of inertia is used to compute slab
stiffness.  The ribs spanning in the transverse direction are not considered in the
stiffness computations.  This thickness, hMI, is given by:

Eq. 2-5
hMI = (    )12MI

Brib

1/3

hv =
Vmod

Amod
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Span System

Continuous l/16 l/18.5 l/21 l/8
Beams

One-Way l/20 l/24 l= /28 l/16
Slabs



where

MI = moment of inertia of one waffle section between centerlines
of ribs.

brib = the center-to-center distance of two ribs (clear rib spacing
plus rib width).

The drop depth for waffle slab systems is set equal to the rib depth; therefore, an
input drop depth of 0 is sufficient.  The equivalent drop depth based on moment of
inertia, dMV, is given by:

ddrop = hslab + hrib – hMI Eq. 2-6

where

hslab = overall thickness of slab.

hrib = rib depth below slab.

hMI = equivalent slab thickness based on moment of inertia.

A drop depth entered for a waffle slab system other than 0 will be added to dMV, thus
extending below the ribs.

The equivalent thickness based on shear area is used to compute the area of concrete
section resisting shear transfer, Ac around the drop.  The equivalent slab thickness,
hV, used to compute Ac, is given by:

Eq. 2-7

where:

Arib = the entire rib area below the slab plus the slab thickness
minus the distance to the reinforcement centroid, dreinf,
within the rib width, (i.e., the slab depth between the ribs is
not considered as contributing to shear resistance.)

brib = the center-to-center distance of two ribs (clear rib spacing
plus rib width).

dreinf = the distance to reinforcement centriod from the slab top at
the support.

hv =         + dreinf
Arib

brib
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Material Properties

By entering the concrete density and compressive strength of the members, default
values for the other concrete properties are determined.  The slab, column, and beam
members may have different concrete properties.

The density of concrete is used to determine the type of concrete, modulus of
elasticity, and self-weight.

For the ACI Code, the concrete type is used to determine the default value of fct, the
average split tensile strength of concrete.  The concrete type is determined in
accordance with Table 2.2.

Note:  The CSA Standard does not use fct

Table 2.2 –Default Concrete Types

Once fć the compressive strength of concrete, is input, various parameters are set to
their default values.  

The modulus of elasticity is computed as:14

Eq. 2-8
Ec= 33w1.5   fc
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Density (w)

pcf kg/m3
Type

w ≥ 130 w ≥ 2000 Normal

105 < w < 130 1700 < w < 2000 Sand-Lightweight

w ≤ 105 w ≤ 1700 All-Lightweight

14 ACI 318-95, 8.5.1; CSA-A23.3-p4, 8.6.2.2



where

w = the density of the concrete. 

For CSA A23.3  

The square root of fć is limited to 100 psi for the computation of shear strength
provided by concrete, Vc, and development lengths.15

Eq. 2-9

Equations 2-8 and 2-9 are used internally and cannot be modified.

The average split tensile strength is used to compute the modulus of rupture and
reinforcement development lengths.  For normal weight concrete, the default value
of fct used by ADOSS is set equal to:16

Eq. 2-10

In no case will fct/6.7 exceed .  fct will be modified according to the concrete
type.  Table 2.3 shows the default values for fct for different concrete types.  No
interpolation is performed for partial sand replacement.

Table 2.3 – Default Average Splitting Tensile Strength

fc

fcfct = 6.7

fcfct = 6.7
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Type fct

Normal 6.7

Sand-Lightweight (0.85) 6.7 

All-Lightweight (0.75) 6.7 fc

fc

Ec= (3300   fc + 6900)(––––)1.5g
2300

15 ACI 318-95, 11.1.2

16 ACI 318-95, 9.5.2.3



The modulus of rupture is used to determine the cracking moment when computing
the effective moment of inertia for deflection computations.  The default value of fr,
modulus of rupture, is set equal to:

For ACI 318

fr =  1.12 fct Eq. 2-11

If fct is that given in Eq. 2-10, Eq. 2-11 is equal to:17

Eq. 2-12

For CSA A23.3 for beams and columns and for slabs.

There is no limit imposed on fr.  Entering a large value of fr will produce deflections
based on gross properties, (i.e., uncracked sections).

The default values for the longitudinal reinforcement yield strength, fy, and shear
reinforcement yield strength, fyv, if applicable, are set equal to 60 ksi (400 MPa).

The Equivalent Frame Method

The equivalent frame method, as described in the Code,18 is used by ADOSS for
both analysis and design.

The Code specifies procedures for the analysis and design of slab systems
reinforced for flexure in more than one direction, with or without beams between
the supports.  A two-way slab19 system, including the slab and its supporting beams,
columns, and walls may be designed by either of the following procedures:

•  The Direct Design Method

•  The Equivalent Frame Method

fcfr = 0.6
2

fcfr = 0.6

fcfr = 7.5
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17 ACI 318-95, Eq.9-9; CSA A23.3-94, 8.6.4 & 13.3.6

18 ACI 318-95, Chapter 13; CSA A23.3-94, Clause 13

19 Implies a slab supported by isolated supports which permits the slab to deflect in 
two orthogonal directions.



ADOSS uses the Equivalent Frame Method of analysis.  It should be noted that this
method is based on extensive analytical and experimental studies conducted at the
University of Illinois.  Note also that there are no restrictions on the number of slab
spans or on dead-to-live load ratios in this method of analysis.

The first step in the frame analysis is to divide the three-dimensional building into
a series of two-dimensional frames extending to the full height of the building.
Horizontal members for each frame are formed by slab strips as shown in Figure
2-6.  For vertical loads, each story (floor and/or roof) may be analyzed separately
with the supporting columns being considered fixed at their remote ends. (Figure
2-7).

Stiffness Characteristics

The stiffnesses and carryover factors are determined for the horizontal members
(the slab beams) and the vertical members (the equivalent columns) using column
analogy, after dividing each member into 220 equal segments.

Slab Beams

The moment of inertia of the slab beam elements between the faces of the columns
(or column capitals) is based on the uncracked section of the concrete including
beams or drop panels. The moment of inertia from the face of the column (or capital)
to the centerline of the column (or capital) is considered finite and is dependent on
the transverse dimensions of the panel and support.  This reduced stiffness (as
compared to the infinite stiffness assumed in previous codes) is intended to soften
the slab at the joint to account for the flexibility of the slab away from the support.
This is consistent with provisions of the Code.20 Figure 2-8 shows the changes in
stiffness between a slab, and a drop panel, and a column (or capital).
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20 ACI 318-95, 13.7.3; CSA-A23.-94, 13.9.2.3



Figure 2-6 Design strips

Figure 2-7 Analytical model for vertical loads for a typical story
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Columns

The computation of the column stiffness is more complicated as it utilizes the
concept of an equivalent column.  Theoretical slab studies have shown that the
positive moment in a slab may increase under pattern loads, even if rigid columns
are used, because of the flexibility of the slab away from the column. However, if a
two-dimensional frame analysis is applied to a structure with rigid columns, pattern
loads will have little effect.  To account for this difference in behavior between slab
structures and frames, the equivalent column torsional member, as shown in Figure
2-9, runs transverse to the direction in which the moments are being determined.
The transverse slab beam can rotate even though the column may be infinitely stiff,
thus permitting moment distribution between adjacent panels.  It is seen that the
stiffness of the equivalent column is affected by both the flexural stiffness of the
columns and the torsional stiffness of the slabs or beams framing into the columns.
Note that the method of computation of column stiffness is in accordance with the
requirements of the Code.21 Figure 2-10 shows a schematic representation of the
stiffness of typical columns.

The column stiffness is based on the column height, lc, measured from mid-depth of
the slab above, to the mid-depth of the slab below.  ADOSS calculates the stiffness
of the column below the design slab, taking into account the design slab system at
its top end.  ADOSS calculates the stiffness of the column above the design slab
taking only the slab depth into account at its top end; column capitals, beams, or
drops are ignored.  

The computation of the torsional stiffness of the member requires several
simplifying assumptions. The first step is to assume dimensions of the transverse
torsional slab-beam members.  Assumptions for dimensions of typical torsional
members are shown in Figure 2-11. 
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21 ACI 318-95, 13.7.4; CSA-A23-94, 13.9



Figure 2-8 Sections for calculating slab-beam stiffness, Ksb
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Figure 2-8  continued
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Figure 2-9 The equivalent column

The stiffness, Kt of the torsional member is given by the following expression:22

Eq. 2-13

where 

Ecs = modulus of elasticity for slab concrete.

C = cross-sectional constant defining torsional properties; see

9EcsCKt = ∑

l 2

c2l   (1-      )2
3
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22 ACI 318-95, Eq. 13-6; CSA-A23.3-94, Eq. 13.13



Eq. 2-14.  It is a conservatively low approximation of the
torsional rigidity of rectangular sections when assuming
elastic behavior.  For the CSA Standard l2 is taken as the
smaller of l2 or l1.

c2 = size of rectangular column or capital measured transverse to
the direction in which moments are being determined.

l2 = For ACI 318 length of span transverse to l1, measured on
each side of the column.  For CSA A23.3 l2 is taken as the
smaller of l2 or l1.

The constant C is evaluated for the cross section by dividing it into separate
rectangular parts and by carrying out the following summation:23

Eq. 2-14

where

x = short overall dimension of the rectangular part of a cross
section.

y = long overall dimension of the rectangular part of a cross
section.

As a result of Eq. 2-13, walls24 running the full width of a slab (c2 =  l2)  cannot be
modeled by the Equivalent Frame Method.

When beams frame into the column in the direction of analysis, the value of Kt as
computed in Eq. 2-13 is multiplied by the ratio of the moment of inertia of the slab
with the beam (Isb) to the moment of inertia of the slab without the beam (Is), as
shown:

Eq. 2-15
Kta = Kt

Isb

Is

C = ∑ (1-0.63   )x
y

x3y
3
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23 CSA-A23.3-94, Eq. 13-14

24 Instead walls can be modeled as long supports less than the full design width of the 
slab.  To obtain a uniform distribution of the end moment along the column and 
middle strips, the width of the wall must be greater than 75% of the design strip.



Figure 2-10  Sections for calculating the stiffness (kc) of the column below the design
floor (lc-input, lc*-computed)
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Figure 2-11  Section of the attached torsional members
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With reference to Figure 2-9, Is is computed from part A, whereas Isb is computed
from both parts A and B.

Knowing the column stiffness, Kc, and the stiffness of the attached torsional
member, Kt, the stiffness of the equivalent column, Kec, is computed from the
equation:

Eq. 2-16

Loading

All applied loads are input as unfactored loads.  There are no limitations imposed
on the ratio of dead to live loads in the Equivalent Frame Method.  Results of gravity
load and lateral load analyses may be combined, however, the effects of cracking and
reinforcement on stiffness must be accounted for in the lateral load analysis.

Self-Weight

The self-weight of the floor system is computed internally by ADOSS.  The weights
of the slabs, drops, and longitudinal and transverse beams are considered in the self
weight computations.  Only the concrete weight is considered, the reinforcement
weight is ignored.  The weight of longitudinal beams is ignored starting at the
column centerline, for a length equal to one-half c1, the column dimension in the
direction of analysis.  This will produce slightly less self-weight than actually
present for beams wider than c2, the column’s transverse dimension.

Superimposed Loading

All superimposed vertical loading is considered to act over the entire transverse
width of the slab.  Vertical loads acting over less than 1/20 of the span length in the
direction of analysis will be averaged over 1/20 the span length by ADOSS.
Concentrated moments are converted into vertical loads producing a couple which
acts over 1/20 the span center-to-center length in the direction of analysis and over
the entire transverse width of the slab.  It may be convenient to consider surface
loading on continuous-beam systems as partial uniform loads.  The surface loading
on T-beams acts over the entire input slab width, even if it is greater than the code

Kec =
Kct + Kcb

Kct + Kcb

Kta + Kta
1+
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allowed T-beam flange width.  For slab systems with beams, loads supported directly
by the beam (such as the weight of the beam stem or a wall supported directly by
the beams) are also assumed to be distributed over the entire transverse width of the
strip.  An additional analysis may be required, with the beam section designed to
carry these loads in addition to the portion of the slab moments assigned to the
beam.

Lateral Loading

For lateral loads, each frame should be analyzed as a unit for the entire height of the
building (Figure 2-12).  Computer programs, such as PCA-FRAME, are available
for performing such analyses.  It should be realized that, for lateral load analysis,
slab-beam elements may have a reduced stiffness due to cracking as well as other
assumptions made for the effective slab width used for the lateral analysis.  The
moments obtained from such an analysis may then be input into the analytical model
to determine the appropriate design moments under combined vertical and lateral
loads.

An alternate but approximate means of computing the effect of lateral loads
incorporated in this program is the use of a modified ”portal method” to determine
the centerline moments.  This method however, is not recommended since it uses
uncracked stiffness for slab-beam elements to resist lateral loads. This modified
portal method is based on the following assumptions:

Figure 2-12  Analytical model for lateral loads
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• shear carried by the column is proportional to its flexural stiffness.

• inflection points exist at midheight of columns.

According to the procedure used in ADOSS, the lateral load is divided in proportion
to the relative stiffnesses of each column.  Moments due to each force are found for
columns above and below.  Note that for positive lateral loads (acting from left to
right) these moments have a positive sign and are balanced at each joint by moments
acting on the slab strip.  These balancing moments are found on the basis of the
stiffness of the slab strips on both sides of the joint.  Note that for positive lateral
loads (acting from left to right) these moments have a negative sign.  Figure 2-13
shows the resulting moments from such an analysis.  See Figure 5-1 for the sign
convention adopted by ADOSS.

By default, ADOSS distributes the effect of lateral load moment, the difference
between the total load moments, vertical plus lateral, and the vertical only moment
envelopes, to the column strip and middle strip according to the code distribution
factors computed for vertical loads (see Tables 2.4 through 2.6 later in this chapter).
However, you may assign a greater percentage of this difference directly to the
column strip.  The remainder will be distributed to the middle strip and the moment
within the column strip will be distributed between the beam and slab according to
the code, if applicable.

Figure0e 2-13  Approximate lateral load analysis
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Loading Patterns

The analysis of floor systems requires the consideration of several loading
combinations.  Fir example, the two adjacent spans loaded may produce the
maximum shear stress around a column, while the alternate spans loaded may
produce the maximum flexural moments.  Furthermore, since the Code25 allows the
use of 75% live load for pattern loading, an additional loading pattern with full
unreduced live load on all spans may be considered.

For vertical loads, the program selects the design requirements for flexure and shear
based on the following loading patterns (Figure 2-14):

Loading Pattern No. l: Two adjacent spans loaded with 75% live load.

Loading Pattern No. 2: Alternate (odd) spans loaded with 75% live load.

Loading Pattern No. 3: Alternate (even) spans loaded with 75% live load.

Loading Pattern No. 4: All spans loaded with 100% live load. 

When moments due to lateral loads are entered as input, or when concentrated
lateral loads are specified, the following additional loading patterns are considered:

Loading Pattern No. 5: All spans loaded with dead load and the effect of
positive lateral loads.26

Loading Pattern No. 6: All spans loaded with dead load and the effect of
negative lateral loads.

Loading Pattern No. 7: All spans loaded with dead and live load and the
effect of positive lateral loads.

Loading Pattern No. 8: All spans loaded with dead and live load and the
effect of negative lateral loads.
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25 ACI 318-95, 13.7.6.3; CSA-A23.3-94, 13.9.4

26 A positive lateral load is defined as a horizontal force acting from left to right on the
equivalent frame at the left end of the frame.  A negative lateral load is defined as a
horizontal force acting from right to left on the equivalent frame at the left end of the
frame  (see Figure 2-13).



Figure 2-14  Basic pattern live loads
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For the ACI 318 Code, the possible combinations of the Dead (D), Live (L), and
Wind (W) loads considered by the program are:

U1 = 1.4D + 1.7L Eq. 2-17

U2 = 0.75(1.4D + 1.7L +1.7W) Eq. 2-18

U3 = 0.75(1.4D + 1.7L – 1.7W) Eq. 2-19

U4 = 0.9D + 1.3W Eq. 2-20

U5 = 0.9D – 1.3W Eq. 2-21

The Eqs. 2-16 through 2-21 show the default values built into the program.

For the CSA-A23.3 Code, the possible combinations of the Dead (D), Live (L), and
Wind (W) loads considered by the program are:

U1 = 1.25D + 1.5L Eq. 2-22

U2 = 1.25D + .7(1.5L + 1.5W) Eq. 2-23

U3  = 1.25D + .7(1.5L – 1.5W) Eq. 2-24

U4 = .85D + 1.5W Eq. 2-25

U5 = .85D – 1.5W Eq. 2-26

The Eqs. 2-22 through 2-26 show the default values built into the program.
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27 Article 4.1.3.2 of the National Building Code of Canada (NBCC), requires that wind
and seismic forces be multiplied by load factors of 1.5 and 1.0, respectively.  ADOSS
makes no such distinction when dealing with these loads.  Unless modified by the user,
ADOSS uses the default live load factor of 1.5 for all designs involving the CSA A23.3
Standard.  Where these designs include the consideration of seismic loads, a modified
seismic load factor of 1.0 should be input by the user.



Column and Middle Strip Widths

The Code28 defines the width of the column strip on each side of the column
centerline as being one-fourth of the smaller of either the transverse or the
longitudinal span.  These widths are printed as part of the echo of input data. 

The strip widths at a support are computed by (see Figure 2-15)

Column strip

Eq. 2-27

Middle strip

Eq. 2-28

The strip widths in the span are defined as:

Column strip

Eq. 2-29

Middle strip

Wms =  l2 - Wcs Eq. 2-30

where 

min(a,b) = the smaller of “a” and “b”.
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28 ACI 318-95, 13.2.1; CSA-A23.3-94, 13.1



Figure 2-15  Strips widths at support

l1 = span length in the direction of analysis. 

l2 = the total input transverse strip width.

l2,1,l2,r = the input transverse strip widths on the left and right of
column dimension, c2, respectively.
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Figure 2-16  Strips widths in span

i, i+1 = span left and right of column dimension c1, respectively.

If a beam exists

Wcs = Wcs – Wb Eq. 2-31

If the beam width is greater than the column strip width, Wcs, then

Wms = Wms –(Wb – Wcs) Eq. 2-32

Wcs = 0 Eq. 2-33

where

Wb = beam width.

For exterior frames, the edge width should be specified to the edge of the slab from
the column centerline.
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Design Moments

ADOSS considers negative moments for design purposes as those producing
tension at the top of the slab.  The negative design moment is taken at a section
located at the face of the column, or column capital, but in no case is it considered
at a location greater than 0.175 of the longitudinal span length, l1, away from the
center of the column.29 This absolute value is a limit on long narrow supports, in
order to prevent undue reduction in the design moment.  For slab systems with
transverse beams, the face of a beam is not considered as the face of support.  For
end columns with capitals, the moments are taken at the midpoint of the capital
extension.30 The column and middle strip moments correspond to the moments
assigned to the slab element only.  

For ACI designs the column strips are proportioned to resist the portions in percent
of interior negative factored moments according to Table 2.4.31

Table 2.4 – Column Strip Percent of Interior Negative Factored
Moments at Supports

The column strips are proportioned to resist the portions in percent of exterior
negative factored moments according to Table 2.5.32
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l/2l/1 0.5 1.0 2.0

(a1l/2l/1) = 0 75 75 75

(a1l/2l/1) ≥ 1.0 90 75 45

29 ACI 318-95, 13.7.7.1; CSA A23.3-94; 13.9.5.1

30 ACI 318-95, 13.7.7.2; CSA A23.3-94; 13.9.5.2

31 ACI 318-95, 13.6.4.1; CSA3-A23.3-M94, 13.12.2

32 ACI 318-95, 13.6.4.2



Table 2.5 – Column Strip Percent of Exterior Factored Moments
at Support

The values a1 in Tables 2.4 and 2.5 and bt in Table 2.5 are defined as:

a1 = ratio of flexural stiffness of the beam section to flexural
stiffness of a width of slab bounded by centerlines of
adjacent panels (if any) on each side of the beam in the
direction of analysis.  For flat plates, flat slabs, and waffle
a1l2l1 = 0.

bt = ratio of torsional stiffness of an edge beam section to
flexural stiffness of a width of slab equal to the span length
of the beam, center-to-center of supports;33 see Eq. 2-34.
When no transverse beams are present, bt = 0.

Eq. 2-34

where

Ecb = modulus of elasticity of beam concrete.

Ecb = modulus of elasticity of slab concrete.

C = cross-sectional constant to define torsional properties; see
Eq. 2-14.

Is = moment of inertia of the gross section of the slab about its
centroidal axis.

EcbC
2EcsIs

ßt =
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l/2l/1 0.5 1.0 2.0

bt = 0 100 100 100
(a1l/2l/1) = 0

bt ≥ 2.5 75 75 75

bt = 0 100 100 100
(a1l/2l/1) ≥ 1.0

bt ≥ 2.5 90 75 45

33 ACI 318-95, 13.0; CSA3-A23.3-94, 13.0



Linear interpolation is performed between values.  When a column width, c2, is
equal to or greater than 75 percent of the strip width, l2 the negative moment is
uniformly distributed across l2.34

When designing by the CSA A23.3 Standard, a portion of the total positive or
interior negative moment equivalent to:

Eq. 2-34a

is resisted by the beam.

For exterior supports the beam is proportioned to resist 100% of the negative moment.

That portion of the moment not resisted by the beam is resisted by the slab.  The
reinforcement required to resist this moment is distributed evenly across the slab.

When lateral loads are present, ADOSS, by default, distributes the effects of lateral
loads according to Tables 2.4 and 2.5.  You may optionally distribute a greater
percentage of the difference between the total load moment and vertical only load
moment directly to the column strip.  In no case, however, will ADOSS distribute
less lateral load moment to the column strip than that required by Tables 2.4 and 2.5,
for ACI, or equation 2-34a for CSA.

The middle strips are proportioned to resist the portion of the total factored
moments that is not resisted by the column strips.

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the
column strip moments if a1l2l1 is equal to or greater than 1.0.  For values of a1l2l1
between 0 and 1.0, the beam is designed to resist a proportionate percentage of the
column strip moment between 0 and 85.35

For design purposes, ADOSS computes the amount of reinforcement for the
moments on the left and right sides of the support.  The negative design moment is
thus the moment which requires the most area of reinforcement to be resisted.  The
location, left or right of the support, of the maximum moment may vary when
systems differ on each side of the support (for example, a system with beams on one
side only). ADOSS considers positive moments for design purposes as those
producing tension at the bottom of the slab.  The column strips are proportioned to

[1 + (l2/l1)2]

α1
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34 ACI 318-95, 13.6.5

35 ACI 318-95, 13.6.5



resist the portions in percent of positive factored moments according to Table 2.6.36

For ACI designs the column strips are proportioned to resist the portions in percent
of factored vertical load moments along the span according to Table 2.6.36

Table 2.6 – Column Strip Percent of Positive Factored Moments

Linear interpolation is performed between values.  Note, for flat plates, flat slabs,
and waffle slabs, a1l2l1 = 0.

When lateral loads are present, ADOSS, by default, distributes the effects of lateral
loads according to Tables 26.  You may optionally distribute a greater  percentage of
the difference between the total load moment and vertical only load moment directly
to the column strip.  In no case, however, will ADOSS distribute less lateral load
moment to the column strip than that required by Tables 2.6.

The middle strips are proportioned to resist the remainder of the total factored
moments.

The longitudinal beams are proportioned to resist 85 percent of the column strip
moments if a1l2l1 is equal to or greater than 1.0.  For values of a1l2l1 between 0 and
1.0, the beam is designed to resist a proportionate percentage of the column strip
moment between 0 and 85.37
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l/2l/1 0.5 1.0 2.0

(a1l/2l/1) = 0 60 60 60

(a1l/2l/1) ≥ 0 90 75 45

36 ACI 318-95, 13.6.4.4

37 ACI 318-95, 13.6.5



Shear Analysis of Slabs

Three types of shear can occur on slab systems: wide beam shear, punching shear,
and moment transfer shear. Wide beam shear or one-way shear on two-way systems
must be checked manually.  This section discusses punching shear including
moment transfer shear.  It is assumed that both types of shear act on the same critical
section. The critical section for shear is defined in the Code.38

Figure 2-17 shows the general shear area used by ADOSS.  Note that the shaded area
represents the general case and is modified for special considerations as explained
below.
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38 ACI 318-95, 11.12.1.2; CSA-A23.3-94, 13.4.3

Figure 2-17  Critical section for shear at column



Shallow beams are considered in the unbalanced moment transfer as indicated in Figure
2-17.  Ordinarily, transverse beams transfer unbalanced moment to the column through
torsion along the beam and not through shear between the slab and column.  However,
the Code leaves the transfer method to the engineer’s judgment concerning the point at
which punching shear is no longer applicable and beam shear becomes the dominate
element in shear transfer to the column. In the default mode of ADOSS, the program
makes no such distinction and computes unbalanced moment transfer stress without
regard to any beams framing into the column.  It is possible, however, to have ADOSS
distribute the shear and torsion among the framing beams.  Although the depth of the
beam is considered in the critical section surfaces, the distances to the critical section
are not increased at the intersection with any beams. This approach is conservative.
ADOSS does not compute torsional stresses or one-way beam shear stresses in the slab.
If in the engineer’s judgment these may control, they must be computed manually.

For a circular column or column capital, a square shape with an equivalent area is
assumed as shown in Figure 2-18.  Critical section area for punching, Ac,  is then
multiplied by p(D + d)/(2D =p + 4d) to account for the difference between circular
and square critical sections, where D is the diameter of a column or a column capital
and “d” is the effective depth of the slab.  

Figure 2-18 Critical section area for circular column
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Critical Section for Interior Supports of Interior Frames

The critical section (Figure 2-19) consists of four vertical surfaces through the slab,
located at distances of d/2 beyond the support faces.  

Figure 2-19 Interior supports of interior frames

For a critical section to be “closed,”  the concrete slab around a column must extend
to a distance greater than or equal to ten times the slab depth, 10h, beyond the
column face.  Otherwise the section is considered “open.”  The critical section for
interior supports of interior frames is always “closed”.  A “closed” section will have
all its faces defined in Figure 2-15, resisting shear as indicated by Eq. 2-35.

Eq. 2-35

If beams frame39 into the column, then the critical section includes the dimensions
of the beams (B1 through B8 in Figure 2-15).

8
Ac = ∑  Ai

i = 1
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Critical Section for Exterior Supports of Interior Frames

The critical section for exterior supports of interior frames (Figure 2-20) will be
either closed (full A7 and A6 for the first column or A2 and A3 for the last column
in Figure 2-17) or open, depending upon the length of the cantilever in relation to
slab thickness.  The critical section will be considered ”closed” when the clear
cantilever span, lc , is greater than or equal to ten times the slab depth, 10h, beyond
the column face.  If beams frame into the column, then the critical section includes
the contributions from the beam dimensions (B2 through B6 in Figure 2-17).

Figure 2-20  Exterior supports of interior  frames

Critical Section for Interior Supports of Exterior Frames

Figure 2-21 shows the critical section for shear for an interior support of an exterior
frame.  Note that the section is considered as U-shaped (A1 = 0, A8 = 0, B1 = 0, B8
= 0 in Figure 2-17) and it extends up to the edge of the exterior face of the support.
If beams frame into the column, then the critical section includes the contribution
from the beam dimensions (B2 through B7 in Figure 2-17).  If the exterior cantilever
span is greater than or equal to ten times the slab depth, 10h, beyond the column
face, the section is treated as “closed”, that is, the support is treated as an interior
support of an interior frame.
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Figure 2-21  Interior supports of exterior frames

Critical Section for Exterior Supports of Exterior Frames

The critical section for an exterior support of an exterior frame (Figure 2-22) will
typically be L-shaped (A1 =0, A6 =0, A7 =0, A8 =0, B1 = 0, B6 =0, B7 = 0 and B8 =
0 in Figure 2-17).

If lc, the clear cantilever span, is greater than or equal to ten times the slab depth,
10h, beyond the column face, then the section is treated as a U-shaped interior
support. If, in addition, the exterior cantilever span is greater than or equal to ten
times the slab depth beyond the column face, 10h, the section is treated as closed.
If beams frame into the column, then the critical section includes the contributions
from the beam dimensions.
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Computation of Allowable Shear Stress at Critical Section

Two-way shear strength of slabs is affected by concrete strength, relationship
between size of loaded area and slab thickness, loaded area aspect ratio, perimeter
area aspect ratio (only for ACI 318-89 code option), and shear-to-moment ratio at
slab-column connections.

For the ACI 318-95 and CSA A23.3-94 Code, these variables are taken into account
in the allowable shear stress Eqs. 2-36 through 2-39.  The allowable shear stress used
by ADOSS is computed at distances of d/2 around the columns and drops (if
applicable) and taken as the smallest of the 3 quantities:40

Eq. 2-36

Eq. 2-37

Eq. 2-38

where

bc = the ratio of the long to the short side of the column.

as = a constant dependent of the column location, (40 for an
interior 4-sided effective critical area, 30 for an exterior
3-sided critical area, 20 for a corner 2-sided effective
critical area.)

d = distance from the slab bottom to centroid of the slab
reinforcement at support.

bo = the perimeter of the critical section.

vc = 4 fc

αsdvc = (2 +        )bo
fc

ßc
vc = (2 +      ) fc

4
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The allowable shear stress around drops  is computed as:

ACI  vc = 2 Eq. 2-39

CSA  vc = 0.2wc

For the ACI 318 Code, if fct is specified or for concrete types other than normal
weight, fct will be substituted for in Eqs. 2-36 through 2-39.41 For waffle slab
systems with valid ribs defined earlier in this chapter, the allowable shear stress is
increased by 10% for ACI designs.42

For CSA designs an additional 1-way shear check is made at end supports of
exterior frames in accordance with CSA A23.3-94 Clause 12.4.6.2

Computation of Factored Shear Force at Critical Section

The factored shear force on the critical section, Vu, by default is computed as the
reaction at the centroid of the critical section (e.g., column centerline for interior
columns) minus the self-weight and any superimposed surface dead and live load
acting within the critical section.  Any partial loads, (uniform, trapezoidal,
concentrated), that act within the critical section are not excluded.  If the section is
considered ”open”, two 45 degree lines are drawn from the column corners to the
nearest slab edge (lines AF and DE in Figure 2-21) and the self-weight and
superimposed surface dead and live loads acting on the area ADEF are also omitted
from Vu (Reference 32).

If beams frame into the column and proportioned moments and shears are requested,
ADOSS computes the optional factored shear force, Vu, assuming that the load is
distributed to the supporting beams.  The factored shear force in the beams with an
a1l2l1 greater than 1 will be computed from the loads on their tributary areas.  These
areas are bounded by two 45 degree lines, originating from the centers of the
columns at the two ends of the beam span, that extend to the edge of the design strip
or to the center of the transverse span (see Figures 2-22 through 2-23).  The shear in
the beams will be reduced by (1 - a1l2l1) for beams with a1l2l1 less than 1.

fc

fc

fc
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Figure 2-24  Tributary area for shear on longitudinal beams

Computation of Unbalanced Moment at Critical Section

The factored unbalanced moment used for shear transfer, Munbal, by default is
computed as the sum of the joint moments to the left and right, taken to the
centroidal axis of the critical section.  
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Figure 2-25  Tributary area for shear on transverse beams

If beams frame into the column and proportioned moments and shears are requested,
ADOSS computes the factored unbalanced moment, assuming that the beams resist
a portion of the moment.  The beams in the direction of analysis are assumed to
attract the percentage of unbalanced moment based on its a1l2l1, value as defined in
the design moments.  The transverse beams are assumed to attract the remaining
unbalanced moment when the b1 value, is greater than or equal to 2.5.

The unbalanced moment applied to the transverse beams is reduced by b1/2.5 for
beams with b1 less than 2.5 and the remainder of the unbalanced moment is
considered directly transferred from the slab to the column.
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Computation of Shear Stresses at Critical Section

The punching shear stress printed by the program is based on the following:43

Eq. 2-40

where 

Vu = factored shear force on the critical section described above.

Ac = area of concrete, including beams if any, resisting shear
transfer.

w = capacity reduction factor as per the Code = .85.

Under conditions of combined shear, Vu, and an unbalanced moment, Munbal,
gvMunbal is assumed to be transferred by eccentricity of shear about the centroidal
axis of the critical section.  The shear stress printed by the program (Reference 2-33)
for this condition corresponds to:44

Eq. 2-41

where 

Munbal= factored unbalanced moment transferred directly from slab
to column, as described above.

gv = is the fraction of unbalanced moment considered
transferred by eccentricity of shear about the centroid of the
assumed critical section.45

gv = (1 – gf) Eq. 2-42

vAB =          +
Vu
wAc

gvMunbal cAB
wJc

vu = 
Vu
wAc
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45 ACI 318-95, Eq. 11-42; CSA-A23.3-94, Eq, 13-8



where

Jc = property of the assumed critical section analogous to polar
moment inertia.

b1 = width of critical section in the direction of analysis.

b2 = width of critical section in the transverse direction.

Direct shear and moment transfer cause stresses in opposite direction on one face of
the critical section.  ADOSS does not check for the shear stress on this face.  If the
stress due to direct shear is less than 20% of the allowable shear stress, and if the
unbalanced moment transferred by shear is greater than 75% of that required for
moment transfer by flexure only, the engineer should manually check46 the shear
stress (vCD) on this other face of the critical section.

Local effects of concentrated loads are not computed by ADOSS and must be
calculated manually.

Shear Analysis of Longitudinal Beams

When longitudinal beams are present in a span, ADOSS will compute the shear
reinforcement requirements for the beams.  When the floor is a continuous beam
system or when proportioning of the moments and shears is not selected for the
beam-supported slab system, ADOSS computes Vu from the load acting over the
entire width of the design strip.  The program makes no distinction between shallow
beams (a1l2l1 less than 1) and deeper beams (a1l2l1 greater than 1).

When proportioning of the moments and shears is selected for the beam supported
slab system, the beams are proportioned to resist shear caused by loads on tributary
areas.  These areas are bounded by two 45 degree lines, originating from the center
of the column at one end of the beam span, that extend to the edges of the design
strip or meet with 45 degree lines drawn from the center of the column at the other

 gf = 
1

1 + (2/3)   b1/b2
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end of the beam, see Figure 2-22.  The shear applied to the beams will be reduced
by 1 - a1l2l1 for beams with a1l2l1 less than 1.  Proportioning of moments and shears
has no effect on continuous beam systems.

The “Beam Shear Requirements” table provides Av/s values, the required area of
two legs of a stirrup, divided by the stirrup spacing.  The values are given at a
distance “d”, the effective beam depth, away from the column face at both the left
and the right ends of the beam.  Values are also given at distances of .175, .375, .625,
and .825 times the center-to-center span length, l1 away from the left support.

For ACI 318 Code:

In beams, the shear strength provided by concrete, Vc, is computed by:47

Eq. 2-43

In CSA design, for beams without minimum stirrup reinforcement and greater than
300mm deep, vc is calculated from the following equation:

When Vu > wVc/2, the beam must be provided with at least a minimum shear
reinforcement of:48

Eq. 2-44
=

Av

s
50bw

fyv

Vc = (                ) lwc        bwd ² 0.10lwc       bwdfc fc
260

1000 + d

fcVc = 2        bwd
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where 

Av = area of two legs of a stirrup,

s = stirrup spacing,

bw = longitudinal beam width, and

fyv = yield strength of the shear reinforcement.

When Vu > wVc, shear reinforcement must be provided so that:

Eq. 2-45

where

Vu = factored shear force at the section being considered, and

d = effective depth of the beam at the same location.

When Vu exceeds w5Vc, the beam section dimensions must be increased or a higher
concrete strength must be provided.50

When segmental moments and shears are requested, ADOSS will print stirrup
spacing for four bar sizes.  When Vu ≤ w10 bwd, the spacing is computed as:

Eq. 2-46

where

Asb = total bar area of the two legged stirrup.

The maximum stirrup spacing must not exceed d/2 nor 24 in. when 
Vu ≤ w6 bwd.  When Vu > w6 bwd, the maximum stirrup spacing must befcfc

Av
s =       Asb 

s

1

fc

=
Av

s
Vu–wVc

wfyvd
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Shear and Torsion Analysis of Transverse Beams

When transverse beams frame into a column, ADOSS will compute the shear and
torsional requirements for each beam at a distance d, the transverse beam effective
depth, away from the transverse face of the column.  The distance to the top
reinforcement from the tension face in the transverse beam is taken as that specified
for the top reinforcement in the slabs.

The shear applied to each transverse beam, Vu, is computed from loads on the beam
tributary area.  These areas are bounded by two 45 degree lines, originating from the
center of the column, that extend to the edge of the design strip or to the centerlines
of the panels parallel to the long side (Figure 2-25).

The torque applied to each transverse beam is computed from the unbalanced
moment as documented below:

Eq. 2-47

Eq. 2-48

where

Tu,1, Tu,r = transverse beam torques on the front and back faces of the
column, respectively.

Kt,1, Kt,r = the torsional stiffness of the transverse beam on the front
and back faces of the column, respectively.

Munbal = the unbalanced moment at the center of the column.

The torque is assumed to be linearly distributed along the transverse beam.  The
maximum torque occurs at the joint center, and zero torque occurs at the slab panel
center, transverse to the design direction (Figure 2-26).

When proportioning of the moments and shears is selected, the shear, Vu, resisted
by the beams will be reduced by 1 - a1l2l1 for beams with an a1l2l1 less than 1.  The

Tu,r = (              ) Munbal 
Kt,r

Kt,1 + Kt,r

Tu,1 = (             ) Munbal 
Kt,1

Kt,1 + Kt,r
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torque applied to the beams will be reduced by bt/2.5 for beams with bt less than
2.5, see Eq. 2-34.

When the applied torque is less than w (Acp
2/Pcp) no torsional reinforcement is

required and the shear reinforcement for the transverse beam is designed using the
procedure for longitudinal beams.53

The shear reinforcement for the transverse beam is designed using the procedure for
longitudinal beams.54

Figure 2-26  Distribution of torque intransverse beams

If the applied shear, Vu, exceeds wVc/2, but is less than wVc and/or the applied
torque, Tu, is greater than w (Acp

2/Pcp) minimal shear and torsional
reinforcement must be provided as follows:55

Eq. 2-52

Av
s

2At
s

+
50Bw

fw
≥

fc

fc
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The total stirrup reinforcement area is computed by:

Eq. 2-53

where

Av = area of two legs of a closed stirrup,

At = area of one leg of a closed stirrup.

When Tu exceeds w (Acp
2/Pcp), the required area of one leg of a closed stirrup

divided by its spacing, At/s, is computed by:56

Eq. 2-54

where 

cotw =  1

When the applied torque exceeds  w (Acp
2/Pcp), the cross-sectional; dimensions

shall be such that:57

Eq. 2-55

The required area for longitudinal torsion reinforcement Al is taken as:58

Eq. 2-56

The maximum value for At/s in Eq. 2-56 is taken as the value obtained from 
Eq. 2-54.

fyvAt

fyts
Al  =      Ph (   )cot2u

(      ) (       +8     )(         ) fc
Vu
bwd

Vc
bwd

TuPh
1.7Aoh

2 2
+ ≤ w

fc

At
s

Tn
2Aofycotw

=

fc

Atot
s

Av
s

2At
s

= +
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Area of Reinforcement

ADOSS only computes reinforcement at the top of the floor system at the supports
and at the bottom of the floor system in the span.  If reinforcement is required at the
bottom of the floor system at a support or at the top of the floor system in the span,
it must be designed manually based on the design moments provided.  The
reinforcement at the support is computed from the negative design moment which
requires the most area of reinforcement to be resisted.  The location, left or right of
the support, of the maximum moment may vary when systems differ on each side of
the support for example, a system with beams on one side only).

For rectangular sections with no compression reinforcement, the design flexural
strength of the column strip, middle strip or beam must equal the factored design
moment:

ACI 318-95

Eq. 2-57

The reinforcement can therefore be computed from:

Eq. 2-58

For CSA A23.3-94

The effective depth of the section is taken as the overall section depth minus the
distance from the extreme tension fiber to the tension reinforcement centroid.  The
column strip depth may include all or part of the drop panel depth.  The drop depth
will not be included in the effective depth of the column strip when the drop does

Mr = fs fy As (d -                    )fs As fy

2(a1wcfć)b

fy w.85fć b
0.85fć b (d –   d2 –               )As =

2Mu

Asfy

2(0.85fć)b
Mu = wfyAs(d –                   )
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not extend at least one-sixth the center-to-center span length in all directions, or
when the drop depth below the slab is less than one-quarter the slab depth.  If the
drop does extend at least one-sixth the center-to-center span length and the drop
depth is greater than one-quarter the distance from the edge of the drop panel to the
face of the column or column capital, the excess depth will not be included in the
column strip effective depth.  If the drop width is less than the column strip width,
the drop width will be used in the computation of the required reinforcement.

Continuous beam systems may be designed as T-beams and may have both tensile
and compressive reinforcement.

In all cases, the steel ratio will be kept below 75 percent rb, where:59

Eq. 2-59

where

rb = 0.85 for ≤ 4 ksi

= = 0.65 for ≥ 8 ksi

= 1.05 – .05 x for 4 ksi < < 8 ksi

If the slab cannot be reinforced, a “cannot design system” message will appear and
the program will terminate prematurely to indicate the need for compression
reinforcement.  In such cases, it is recommended that the engineer review the slab
thickness to ensure a more satisfactory design.  For continuous beam systems,
ADOSS will attempt to add compression reinforcement to the section.

The amount of reinforcement provided will not be less than the code prescribed
minimum.  For the ACI 318 Code, the minimum ratio of reinforcement area, to the
gross sectional area of the slab strip, using Grade 60 reinforcement, is taken as
.0018.  When reinforcement yield strength exceeds 60 ksi, the minimum ratio is set
to .0018 x 60/fy.  For reinforcement with yield strength less than 60 ksi, the
minimum ratio is set to 0.0020.  In no case will this ratio be less than .001460.  (See
Table 2.7).  The CSA Standard requires a minimum ratio of slab reinforcement area
to gross sectional area of the slab strip equal to 0.002 for all grades of reinforcement.

fcfc

fc

fc

fy

fć

87 + fy 

87
rb = .85b1
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For beams and positive moment regions of waffle slabs, minimum reinforcement
ratio, r,provided will not be less than:61

Eq. 2-60

but not less than 200bwd/fy

Table 2.7 – Minimum Ratios of Reinforcement to Gross 
Concrete Area

Reinforcement Selection

The ADOSS default minimum spacing of reinforcement is 6 in. (150 mm) in slabs
and 1 in. (25 mm) in beams.  The 6 in. minimum for slabs was chosen for practical
reasons only.  The minimum in no case will be less than the Code prescribed minima
for both slabs and beams of one bar diameter, db, or 1 in.62

For ACI 318 the maximum spacing of reinforcement is kept at two times the slab
thickness.63

For CSA A23.3 banded reinforcement is spaced at a maximum of 1.5 hs while
distributed reinforcement is spread at a maximum of 3 hs.

An iterative process is performed to determine the number of bars and bar size.  The
initial number of bars is determined by dividing the total reinforcement area required,
As, by the area of one bar, Asb, of the input minimum bar size.  An additional bar is

fy

3  fć
As,min =          bwd
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61 ACI 318-95, 10.5

62 ACI 318-95, 7.6.1

63 ACI 318-95, 13.4.2



provided if the difference between the required and the provided reinforcement areas
is greater than 20% of one bar area or 0.2 in.2.  Next, the spacing is determined.  If
the minimum spacing limitations are violated, the bar size is increased and the
iterative process continues until all bars sizes have been checked.  If the maximum
spacing limitations are not met, the number of bars required to satisfy these
limitations is computed and the iteration process terminates.

For beams, layered reinforcement is provided if sufficient beam width is not available.
ADOSS assumes a 1.5 in. cover to a #4 (an SI N-10) stirrup for width calculations.
ADOSS also assumes that the longitudinal bar makes contact at the middle of the
stirrup bend where the minimum inside diameter of the bend is 4db.  Therefore, an
additional width is added to the cover for longitudinal bars less than #14 (an SI N-45)
in size (Figure 2-25).  This additional width due to the bend, wbend, is equal to:

wbend = 0.293 (1.0 – db/2) Eq. 2-61

where

db = bar diameter of the longitudinal bar.

The clear distance between layers is assumed 1.0 in.  Hooks and bends are not
included in bar length figures.

Figure 2-27  Width due to stirrup bend
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Figure 2-28  Detail of reinforcement in longitudinal beams

Bar-length computations are performed for two-way slabs only.  For reinforcement
at the top of the slab at the supports, the length for short bars is given by:

Eq. 2-62

and the length for long bars is given by:

Eq. 2-63

llong = greater of {max lip, + greater of {
ld, short + lcr {

d
12db
ln/16

0.5 max (lip)
ld short + lcr

lshort = greater of {0.5 max ( lip) + greater of {
ld, short + lcr 

d
12db
ln/16
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where

max(lip) = maximum distance to the inflection points, where the
distances are the same for both the column and middle
strips,

ld = bar development length,66

d = effective, depth,

db = bar diameter,

ln - clear span length.

These bar lengths are then compared and adjusted if necessary to the minimum
requirements specified by the code.67

If the computed bar lengths overlap, it is recommended that such reinforcement be
run continuously.  The printed bar lengths do not include hooks or portions of bars
bent down into spandrel beams or other bar-bend configurations.

The selection of bar lengths for positive reinforcement for flat plates, flat slabs, and
beam-supported slabs, is based strictly on the minimum values of the Code.  For
waffle slabs, however, the positive reinforcement selection is based on an additional
assumption of two bars per joist.  For purposes or output, one bar is treated as a long
bar and the other as a short bar.

The computation of tension development lengths in terms of db is given by the
general expression:

Eq. 2-64

The development length depends on some of the following factors: concrete cover,
minimum transverse reinforcement, special transverse reinforcement, layer location
bar size and bar clear spacing.  

ld
db

=
3

40

fy abgl

fc
db

c + kcr[         ]
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Additional Reinforcement at Support

ADOSS computes the fraction of the unbalanced moment, gfMu, that must be
transferred by flexure within an effective slab width equal to the column width plus
one and one-half the slab or drop panel depth (1.5h) on either side of the column
where:68

Eq. 2-65

The amount of reinforcement required to resist this moment is computed.  The
amount of reinforcement already provided for negative flexure is then computed
from the bar schedule (i.e. the number of bars that fall within the effective slab width
multiplied by the area of each bar).  If the reinforcement area provided for flexure
is greater than or equal to the reinforcement requirements to resist moment transfer
by flexure, no additional reinforcement is provided, and the number of additional
bars will be set to 0.  If the amount of reinforcement provided for flexure is less than
that required for moment transfer by flexure, additional reinforcement is required.
The additional reinforcement is the difference between that required for unbalanced
moment transfer by flexure and that provided for design bending moment in the
slab, and it is selected based on the bar size already provided at the support.

It should be noted that the Code requires either concentration of reinforcement over
column beam joint by closer spacing, or additional reinforcement, to resist the
transfer moment within the effective slab width.  ADOSS provides additional
reinforcement, and does not concentrate existing reinforcement.

For the ACI Codes, at least two of the column strip bottom bars should be
continuous or spliced at the support with Class A splices or anchored with the
support.

gf =
1

1 +         b1/b2
2
3
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Additional Information in Span

The total static design moment for each span based on average widths and loads on
the span is computed as per the Code.  Partial loads are not taken into account.  

Deflection Calculation

Calculation of deflections of reinforced concrete two-way slabs is complicated by a
large number of significant parameters such as: the aspect ratio of the panels, the
vertical and torsional deflection of supporting beams, the stiffening effect of drop
panels and column capitals, cracking, and the time-dependent nature of the material
response. Based on studies in References 2-22–2-24, an approximate method
consistent with the equivalent frame method was developed (2-25) to estimate the
column and middle strip deflections.

Under vertical loads, Reference 2-23 indicates that the midspan deflection of an
equivalent frame can be considered as the sum  of three parts:  that of the panel
assumed to be fixed at both ends of its span, and those due to the known rotation at
the two support lines.  The midspan “reference” deflection of a uniformly loaded
equivalent frame with fixed ends is:

Eq. 2-66

where

W = is the uniform load in units of weight per length squared,

Ec = modulus of elasticity of the slab concrete,

Iframe = moment of inertia of the full-panel width.

Calculation of the midspan deflection of the column strip or the middle strip under
fixed-end conditions is based on the M/EI ratio of the strip to that of the full-width
panel:

Eq. 2-67

af,strip = af,ref
Mstrip    EcIframe

Mframe    EcIstrip

af,ref =
Wl 4

384EcIframe
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The ratio (Mstrip/Mframe) can be considered as a lateral distribution factor, LDF.  The
lateral distribution factor, LDF, at an exterior negative moment region is:

Eq. 2-68

The LDF at an interior negative moment region is:

Eq. 2-69

The LDF at a positive moment region is:

Eq. 2-70

where

a1 = the ratio of flexural stiffness of a beam section to the
flexural stiffness of a width of slab bounded laterally by
centerlines of adjacent panels on either side of the beam.

bt = ratio of torsional stiffness of an edge beam section to the
flexural stiffness of a width of slab equal to the span length
of the beam, center-to-center of the supports.  (See Eq.
2-34)

When a1l2l1 is greater than 1.0, a1l2l1 will be set equal to 1.0.

The column and middle strip LDF’s can be computed by:

Eq. 2-71

Eq. 2-72
LDFm = 100 - LDFc

LDFc =
LDFpos +

LDFneg,l + LDFneg,r

2
2

LDFpos = 60 + 30(a1 – )(1.5 – – )
l2
l1

l2
l1

LDFneg,int = 75 – 30(a1 – )(1 – – )
l2
l1

l2
l1

LDFneg,ext = 100 – 10bt + 12bt(a1 – )(1 – – )
l2
l1

l2
l1
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where

LDFneg,1,  = LDF for the negative moment region at the left and right 
LDFneg,r end of the span, respectively.

If the ends of the columns at the floors above and below are assumed fixed (as is
usual in an equivalent frame analysis), then the rotation of the column is equal to the
net applied unbalanced moment divided by the stiffness of the equivalent column:

Eq. 2-73

The midspan deflection of the panel having an end rotation of Q radians, with the
far end fixed, can be computed as:

Eq. 2-74

The total midspan deflection for the column or middle strip is the sum of the three
parts:

Eq. 2-75

where

= midspan deflection due to rotation of left and right supports,
respectively.

The deflections should be used in conjunction with the deflections obtained from an
analysis in the perpendicular direction.  For square panels (l1 = l2), the midpanel
deflection is obtained by Eq. 2-736a as shown in Figure 2-29:

Eq. 2-76a

For rectangular panels, (l1 ≠ l2), the midpanel deflection is obtained by Eq. 2-76b:

a = acy + amx = acx + amy

au,l, au,r

astrip = af,strip + au,l + au,r

au =
ul

8

u =
Munbal

Kec
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Eq. 2-76b

For cantilever spans, Eq. 2-66 must be modified to:

Eq. 2-77

where

Pi = load within segment i of the cantilever span, 

xi = distance of load Pi from the support,

l = cantilever span.

Eq. 2-78au = ul

af,ref  =
20
∑

i = 1

Pi xi
2 (3l – xi)

6EcIframe

a = [(acy + amx) + (amy + acx)]/2
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Figure 2-29  Deflection computation for a square panel

Note that the value of Iframe in Eq. 2-77 is taken as the effective moment of inertia
at the support. Also, this method is applicable to short cantilevers and small loads.
Deflections due to large loads and long cantilevers must  be computed manually.
Local deflections due to concentrated loads are not considered by the program and
must be computed manually.
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Deflections of Continuous Beams and One Way Slabs

Continuous beam and one way slab deflections are computed based on simply
supported deflections less the deflection due to the end support rotations. The
effects of support settlement or shear deformations are not considered. When
segmental moments and shears are requested, the segmental deflections printed are
at 20 equally spaced sections along the span. Concentrated loads occurring at other
locations will give rise to larger deflections. These must be checked manually.

Cracking

The effect of cracking in slabs, as in beams, is a reduction in the flexural stiffness.
The effect of cracking is generally an increase in deflections, although the tensile
concrete between cracks continues to have a stiffening influence. A detailed review
of several methods of deflection analyses can be found in Reference 2-24.  To apply
the Code-specified effective moment of inertia to slab systems, a value of Ia,frame is
used instead of Ia,frame in Eqs. 2-66, 2-67, and 2-77.  The value of Ia,frame is given
by:

Eq. 2-79a

where

Ie
+ = effective moment of inertia for the positive moment region.

Ie
–
,l = effective moment of inertia for the negative moment region

at left support.

Ie
–
,r = effective moment of inertia for the negative moment region

at right support.

b an empirical constant based on experimental data, whose
value is less than 1.0.

For continuous beams, the appropriate value of b compatible with experimental data
was found  to be 0.7.  For flat plates, flat slabs, and waffle slabs, the appropriate
value of b appears to be 0.5.  ADOSS uses a value of 0.5 for flat plates, flat slabs,
and waffle slab systems and 0.7 for beam-supported slabs, continuous beams, and
one way slabs.

Ia,frame  = bIe
+ + (1–b) (Ie

-,l + Ie,r
-)/2
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The value of Ia,frame for cantilever spans is given by:

Eq. 2-79b

where

Ie
–
,end = effective moment of inertia for the negative moment region

at the cantilever end.

Ie
–
,sup = effective moment of inertia for the negative moment region

at support.

For continuous beams, the appropriate value of b compatible with experimental data
was found to be 0.15.  For flat plates, flat slabs, and waffle slabs, the appropriate
value of b appears to be 1.0.  ADOSS uses a value of 1.0 for flat plates, flat slabs,
waffle slabs, and beam-supported slabs, and 0.15 for continuous beams, and
one-way slabs.

The value of Ie corresponds to the effective moment of inertia as developed by
Bramson (2-26) and incorporated into the Code as follows:69

Eq. 2-80

where

Ig = moment of inertia of the gross uncracked concrete section
for the full width of the equivalent frame.

Icr = moment of inertia of the cracked transformed concrete
section for the full width of the equivalent frame.

Mcr = cracking moment for the full width of the equivalent frame.  

Mmax = maximum bending moment for the full width of the
equivalent frame at the load stage at which deflection is
computed.

It should be noted that the use of the full slab width in determining Ie in Eq. 2-77 is
intended to average the effects of cracking of the column and middle strips.

Ic = {    }3
 Ig

 + [1–{    }3
]Icr

Mcr
Mmax

Mcr
Mmax

Ia,frame  = bIe
-
,sup + (1–b) Ie

-
,end
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Deflection Computations

Instantaneous Deflections. Two values of midspan deflections are computed by
the program for each span. The first corresponds to dead load on all spans, while the
second corresponds to dead load plus live load on all spans. Note that the live load
deflection is always computed as total load deflection minus the dead load
defection.  This is consistent with the Ieff method outlined in the Code 

Long Time Deflections. The total midpanel deflection (including long-time
effects) consists of the following:

Eq. 2-81

where

a = elastic deflection,

acreep = additional deflection due to creep,

ash = additional deflection due to shrinkage, and

atotal = total deflection.

Data reported in the literature, although limited in quantity, indicate that the
additional deflection due to creep and shrinkage, acreep + ash, may be as much as two
to eight times the elastic deflection, a (References 2-27–2-30). Such a factor times
the dead load deflection may be used for an estimate of required slab camber.

For a crude approximation to a complex problem, additional long-time deflections
may be computed as three times the elastic deflections.  For a more detailed method
of analysis of long-time deflection the user is referred to a study by Rangan.
(Reference 2-30.)

atotal = a + acreep + ash
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Material Quantities

The program computes concrete, reinforcing steel, and formwork quantities. The
quantity of concrete is based on an average of the slab, drop, and beam sizes.  The
total quantity of reinforcing steel computed by the program corresponds to the
actual bar sizes and lengths required by design. No allowance is made for bar hooks,
anchorage embedment, and so forth.  It should be noted that the quantity of
reinforcement printed by the program pertains to bending in one direction only.  In
practice, the total amount of reinforcement for the structure should also include the
quantities obtained for the appropriate perpendicular equivalent frames. 
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Chapter 3 

Menu Descriptions

ADOSS Graphics Menu Descriptions

ADOSS Graphics uses pull down menus to access commands that allow input of the
floor geometry, manipulate ways to view the system, and ultimately design the
system and review the results.  This section gives a summary of each command in all
the pull down menus.  Use this chapter to learn what functions ADOSS commands
perform.

The File Menu

The File menu is used for saving or retrieving data, printing, and exiting.  The File
menu contains the following commands: New, Open, Save, Save As, Export, Revert,
Print Screen, Print Results, and Exit. 

New
The New command clears any data input, returns to the default values, and begins
the Auto Input process (see the “Auto Input” command from the Input menu later in
this chapter).  Thus, you are able to create a new data file.  However, before you can
begin a new data file, ADOSS will ask whether you want to save the current data.
Answering yes will save the old data and begin a new data file.  Answering no will
discard any changes to the data and begin a new data file.  Answering cancel will
return you to ADOSS so that you can continue to work with the current data. 

See ”Creating a New Data File” of Chapter 4 for more information on using the
New command.

Open
The Open command allows you to load an existing ADOSS data file.  The dialog
box that appears shows you a listing of all the files with the extension contained in
the default data directory or in the current directory (if a default data directory was
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not specified).  This box also enables you to change the current drive and directory.
If you are currently working on a data file and select the Open command, ADOSS
will ask whether you want to save the current data.  Answering Yes will save the old
data and display the Open dialog box.  Answering No will discard any changes to
the data and display the Open dialog box.  Answering cancel will return you to
ADOSS so that you can continue to work with the current data. 

See ”Opening an Existing Data File” of Chapter 4 for more information on using the
Open command.

Save
The Save command saves the changes you’ve made to the current data under that
same filename.  The new data overwrites the old data, and you cannot retrieve the
old data.  It is a good practice to periodically Save while inputting data.  If a data
file is untitled, the Save As dialog box will appear.

See ”Saving Your Data” of Chapter 4 for more information on using the Save
command.

Save As
The Save As command allows you to name or rename a data file.  Use Save As when
you want to save both the original data and any changes you’ve currently made to
the data.  The original data remains under the old filename.  If a file of the same
name exists, the program will ask if you would like to overwrite the file.

See “Saving Your Data” of Chapter 4 for more information on using the Save
command.

Export
The Export command saves the current data file into a file format other than the
default format.  By using the “ADOSS V4.X-V5.2X” conversion utility from the
provided list, the Export command ensures compatibility between ADOSS V6.00
and previous versions by converting V6.00 data files to a format that is readable by
previous versions.

See ”Saving Your Data” of Chapter 4 for more information on using the Save
command.
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Revert
The Revert command is used to discard current changes to the data and return to the
version of data saved in the original data file.  This option will only be enabled if
the file had been saved prior to editing.

Print Results
The Print Results command allows you to send the analysis and design results to the
printer.  By selecting options in the Output Options command prior to performing
the design, you can print selected sections of the data instead of the entire analysis.

See “Viewing and Printing the Results” and ”Condensing the Output” of Chapter 4
for more information on using the Print Results command.

Print Screen
The Print Screen command prints the floor system geometry in the plan, elevated,
and isometric views, prints the shear and moment diagrams, and prints the deflected
shapes.  To obtain a print you must first perform the design of the view, then view
the shear and moment diagrams or the deflected shapes.

See “Viewing and Printing Shear and Moment Diagrams” and “Viewing and
Printing Deflected Shapes” of Chapter 4 on using the Print Screen command.

Exit
The Exit command ends the ADOSS session and returns you to Windows.  If you’ve
made any changes to your data and have not saved them, ADOSS will first ask
whether you want to save or abandon any changes you’ve made before you exit.
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The Input Menu

The Input menu allows you to enter and modify data for the floor system.  

Auto Input
The Auto Input command is designed to make the inputting process easier.  By
selecting Auto Input, a logical sequence of dialog boxes will automatically be
displayed allowing you to enter data for your floor system.  Depending on the floor
system selected, the program will display only those dialog boxes required to design
your floor system.

See ”Creating a New Data File” of Chapter 4 for more information on using the
Auto Input command.

Labels
The Labels command allows you to enter the project name, span id, engineer, date,
and time.  Date and time are automatically filled when a new file is created.  This
information will be printed with the output and is intended to help you organize your
data.

See “Including Labels with the Output” of Chapter 4 for more information on using
the Labels command.

General Information
The General Information command will allow you to enter the number of spans, units,
code, structure type, frame location, lateral loads, loading pattern, and the design
option.  You must always choose the General Information command before doing any
further inputting since it affects the availability of other commands in this menu.

See “Using the General Information Command” of Chapter 4 for more information
on using the General Information command.

Material Properties
The Material Properties command enables you to input material property
requirements for concrete and reinforcement.  Concrete density, compressive
strength, tensile splitting strength, modulus of rupture, as well as the longitudinal
and shear reinforcement yield levels are required.
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See “Defining the Material Properties” of Chapter 4 for more information on using
the Material Properties command.

Reinforcement Data
The Reinforcement menu contains commands that allow you to specify the distance
to reinforcement, reinforcement bar sizes, and minimum bar spacing for both slabs
and beams.  Depending on the type of floor system you have selected, either Slabs
or Beams or both of these commands will be available.

See “Defining Reinforcement Parameters” of Chapter 4 for more information on
using the Reinforcement Data menu.

Geometry
The Geometry menu contains commands that allow you to input geometric
dimensions for slabs, ribs, longitudinal beams, columns/capitals, drops, and
transverse beams.  A cascading menu contains the member types to modify.
Depending on the floor system, some menu items will be disabled.

See “Defining the Structure Geometry” of Chapter 4 for more information on using
the Geometry menu.

Loads
The Loads menu contains commands that allow you to enter superimposed uniform
loads, trapezoidal loads, concentrated axial loads and moments, lateral loads, and
allows you to modify the load factors.  Depending on the lateral load type, some
menu items will be disabled.

See “Specifying Loads on the Structure” and “Using the General Information
Command” of Chapter 4 for more information on using the Loads menu.

Column Fixity
The Column Fixity command allows you to modify the percentage of the actual
column joint stiffness to be used in the analysis to determine the joint moments and
shears.

See “Changing the Column Fixity” of Chapter 4 for more information on using the
Column Fixity command.

Menu Descriptions 3-5

ADOSS Graphics



The View Menu

The View menu commands enable you to modify the floor system’s appearance on the
screen to suit your viewing needs.  The following is a list of what is available in this menu.

Redraw
The Redraw command will redraw the floor system in full size.  If you have altered
your screen view using the Zoom command, select Redraw to restore the figure’s
original proportions.

Scale On/Off
The Scale On/Off commands allow you to view your floor system with or without a
scale in ft. (m) along the left and top edge of the view window.  The left edge of the
floor system and the column centerline is considered the origin.

See “Viewing the Floor System with a Scale” of Chapter 4 for more information on
using the Scale On/Off commands.

Zoom
The Zoom command enables you to zoom in on any portion of your floor system for
closer analysis.  By selecting zoom and either using the mouse or keyboard arrow
keys to specify a zooming region, the program will enlarge the portion you select.

See “Zooming in on the System” of Chapter 4 for more information on using the
Zoom command.

Change Isometric Angle
The Change Isometric Angle command allows you to modify the angle at which the
floor system is displayed in the Isometric View.  The default angles are set at -45
about the X and 45 about the Z axis.

See “Changing the Isometric View Angle” of Chapter 4 for more information on
using the Change Isometric Angle.

View Members
The View Members command allows you to view selected members of the floor
system in the views windows.  Clicking the left mouse button on the box next to the
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items in the dialog box, or tabbing to the member type and pressing the space bar will
toggle the selection.  ADOSS will draw any members that contain a check in the box.

See “Viewing Specific Member Types” of Chapter 4 for more information on using
the View Members command.

View Loads
The View Loads command allows you to view selected loads of the floor system in
the Partial Loads window.  Clicking the left mouse button on the box next to the
items in the dialog box, or tabbing to the type and pressing the space bar will toggle
the selection.  ADOSS will draw any loads that contain a check in the box.

See “Viewing Specific Load Types” of Chapter 4 for more information on using the
View Loads command.

View Results
The View Results command will execute PCA View, so you may view the design
results for your floor system on the screen after a design has been performed.  The
PCA View window, displaying the results, will overlap the main window of the
ADOSS program.

See “Viewing and Printing the Results” of Chapter 4 for more information on using
the View Results command.

View Shears/Moment
The View Shears/Moments command creates a window displaying a shear and
moment diagrams of a particular span and load pattern after a design of the floor
system has been performed.

See “Viewing and Printing Shear and Moment Diagrams” of Chapter 4 for more
information on using the View Shear/Moment command.

View Deflections
The View Deflections command creates a window displaying the deflected shape of
a particular span of a continuous beam or one-way slab system after a design of the
floor system has been performed.

See “Viewing and Printing the Deflected Shapes” of Chapter 4 for more information
on using the View Deflections  command.
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The Design Menu

The Design menu contains commands that enable you to perform the analysis and
design of the floor system or column section.

Condense/Expand Output 
The Condense/Expand Output command allows you to suppress portions of the
output.  ADOSS will print only those items that have a check in the box.  To take
effect, the design must be performed after the Condense/Expand Output command
is executed.

See “Condensing the Output” of Chapter 4 for more information on using the
Condense/Expand Output command.

Design System
The Design System command executes the solver portion of ADOSS.  If some data
is still required when this command is executed, ADOSS will respond with ”More
data required” and display the dialog box that must be completed.

See “Designing the Floor System” of Chapter 4 for more information on using the
Design System command.

Design Column
The Design Column command executes PCACOL if it is found on the computer
system.  This option will be grayed if PCACOL is not found after the design of the
floor system is performed.  In order for ADOSS to find PCACOL, the directory
where PCACOL resides must be in the DOS PATH statement.  (See your DOS
manual for help on the PATH statement.)

See “Designing the Column” of Chapter 4 for more information on using the Design
Column command.

3-8 Menu Descriptions

ADOSS Graphics



The Options Menu

The Options menu allows you to change the startup options of the ADOSS program
to suit your needs.  These changes are saved in the PCAPROGS.INI file and they
become the default settings when ADOSS is executed.

Background Color
The Background Color command allows you to change the background of the three
views windows to black or white.  The background color chosen will become the
default background color when ADOSS is executed.

See “Changing the Background Color” of Chapter 4 for more information on using
the Background Color command.

Member Colors
The Member Colors command allows you to change the colors of the individual
member types of the floor system views.  This option will only be available on
systems that support color.  These colors will become the default colors when
ADOSS is executed.

See “Changing the Member Colors” and “Changing Background Colors” of
Chapter 4 for more information on using the Member Colors command.

Load Colors
The Load Colors command allows you to change the colors of the individual load
types of the loads window.  This option will only be available on systems that
support color.  These colors will become the default colors when ADOSS is
executed.

See “Changing the Load Colors” of Chapter 4 for more information on using the
Load Colors command.

Default Units/Code
The Default Units/Code command allows you to change the default units and code
used at startup that were set during the ADOSS installation.  The choices set here
will become the defaults when ADOSS is executed.

See “Changing the Default Units and Code” of Chapter 4 for more information on
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using the Default Units/Code command.

Default Data Directory
The Default Data Directory command allows you to modify the directory where
ADOSS looks for data when it is executed, changing the directory specified during
the ADOSS installation.

See “Changing the Default Data Directory” of Chapter 4 for more information on
using the Default Data Directory command.

Page Layout
The Page Layout command allows you to set the left, right, top, and bottom margins
of the print screens.

See “Changing the Margins of a Screen Print”, “Viewing and Printing Shear and
Moment Diagrams”, and “Viewing and Printing the Deflected Shapes” of Chapter
4 for more information on using the Page Layout command.

The Window Menu

Once all the data for the floor system has been input, there are three ways in which
to view your model: Plan View, Elevated View, and Isometric View.  This menu
enables you to arrange and select different view settings for these windows along
with any shear and moment windows, or deflected shape windows.

See “Manipulating Windows” of Chapter 4 for more information on using the
commands in the Window menu.

Cascade
The Cascade command displays all the open windows in the same size, arranging
them on top of each other so that the title bar of each is visible.

Tile All Windows
The Tile All Windows command arranges all open windows so that no window
overlaps another.
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Tile Views Windows
The Tile Views Windows command arranges the open view windows on your screen
without overlapping them.  If all the view windows are open, the windows will be
arranged so that Isometric View is a half page display and Plan View and Elevated
View each share the other half.  The Shear/Moments and Deflection windows (if
opened) will not be displayed.

Arrange Icons
The Arrange Icons command will align all the icons present at the bottom of the
screen.

Remaining Commands
The remaining menu items is a list of the windows that are available for viewing.
Selecting any window from this menu will restore the window to its previous size
and position from an icon.

The Help Menu

The Help menu includes commands that enable you to obtain online help for the
ADOSS program.  The help screens in the program are closely related with Chapters
3 and 4 of this manual. 

See “Using On-line Help” of Chapter 4 for more information on using the
commands in the Help menu.

Index
The Index command lists all the available help topics.  Click on any underlined topic
and a help screen appears with information about that item.  More information on
the help system can be obtained from the Microsoft Windows manual.

Commands
Selecting Commands lists all the available commands found in the ADOSS
program, similar to this chapter.  Click on any underlined command and a help
screen appears with information about that command.

Menu Descriptions 3-11

ADOSS Graphics



Procedures
The Procedures command lists several procedures on ADOSS operation, similar to
Chapter 4.  Click on any underlined topic and a help screen appears with
information about that procedure.

Using Help
The Using Help command gives help on using the Microsoft Windows help system.

About ADOSS
The About ADOSS command displays a dialog box that gives you copyright
information, the version number of the ADOSS program, your firm name, city, and
state.

The Control Menu

All the view windows have one pull-down menu located in the upper left hand
corner of the open window.  This is the Control menu.  To access the Control menu,
press  Enter +  F6 to cycle through the windows and press  Alt +  –  , hyphen,
to open the Control menu of the desired window.  The following is a list and a brief
description of the commands in this menu.

Note:  See “Basic Skills” of Chapter 2 in the Microsoft Windows User Guide for
more information on using the commands in the Control menu.

Restore
The Restore command will restore a window or an icon to its previous size and
position.  This menu item is available when the window is iconized or maximized.

Move
The Move command moves the window to a new location.  Select Move and use the
arrow keys to move the window in the desired direction and select Enter to accept
the new location.

Size
The Size command resizes a window.  Select Size and use the arrow keys to move
the border of the window in the desired direction and select Enter to accept the
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new size.

Minimize
The Minimize command reduces a window to an icon and positions it at the bottom
of the screen.

Maximize
The Maximize command enlarges a window to fit your entire screen.

Close
The Close command is used to close a window and return it to an icon and the
bottom of the screen.

Next
The Next command switches among open windows and icons.
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Chapter 4 

Operating the Program

This chapter is designed to help you work with menus and inputting data into dialog
boxes.  It is divided up into different sections that follow operating procedures
needed to complete the input process and design a floor system.  Use this chapter to
guide you through inputting, for quick reference on particular sections, or to help
answer any questions you may have about the program.  

Main Screen Components

The following is a list of the main screen components you must know in order to
understand the operating procedures of ADOSS in this chapter.

You must have a copy of Microsoft Windows 3.0 or higher already installed on your
system to be able to use ADOSS.  An advantage to working with Windows is that
you always have your options listed in front of you.  Figure 4-1 illustrates how your
screen will look when you have loaded ADOSS.

Title Bar

Refer back to Figure 4-1 to locate the title bar at the top of the screen.  The title bar
displays the ADOSS name, and following the hyphen, displays the name of the
current data file you are using.  If the data you are currently working on has not been
saved into a file, the word Untitled is displayed in the title bar.

Control Menu

Each window has a Control menu located to the left of the title bar, in the upper left
corner of the window.  This menu contains commands that allows you to manipulate
that particular window.  To access the Control menu using the mouse, click the left
mouse button on the box in the upper left corner.  To access the Control menu using
the keyboard, press  Ctrl + F6 to cycle through the windows until you reach the
desired window and press Alt  +  –  , hyphen.
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Figure 4-1  The ADOSS main window

Menu Line

Located directly below the title bar is the menu line.  ADOSS commands are listed
in the pop-up menus located in the menu line.  These menu commands allow you to
perform functions that create, view, and ultimately design the floor system.

In the ADOSS program there are seven main pop-up menus:  File, Input, View,
Design Options, Windows, and Help.  To access a menu item using the mouse, place
the arrow cursor on the menu item you want and click the left mouse button.  Each
menu item can also be selected with the keyboard keys by simultaneously pressing
the Alt key and the underlined letter of the menu you want to open.  For example,
to open the File menu, press Alt + F  .

To close a menu without selecting a command, move the cursor to any blank area on
the screen and click the left mouse button.  Press Esc to close a menu using the
keyboard keys.

To select a command from a menu with the mouse, place the arrow on the item you
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want, and click the left mouse button.  In some cases, you will be told to double
click on a selection, that is, press the mouse button twice, quickly.  Anytime you
have to wait, for example, when loading the program or designing the system, the
mouse cursor becomes an hourglass cursor.  It will return to its original state when
the task is completed.

To select a command from a menu using the keyboard, use the down arrow key to
highlight your choice and press Enter or press the keyboard key of the command’s
underlined letter.  The space bar is also equivalent to pressing the left mouse button.
Special instructions for inputting with the keyboard keys are given wherever
necessary.

Dialog Boxes

Dialog boxes are used to request information or provide you with information. By
selecting a command from a menu, a dialog box may be displayed requesting data
to complete the command. A dialog box will follow any command that contains
three trailing periods, “...”.   After entering the required data, press the  Ok button
so that the data associated with that dialog box will be acted upon.

Edit Boxes

Edit boxes are rectangular boxes inside dialog boxes that require text to be
completed.  In some cases, the edit box will contain only a flashing cursor located
at the left side of the box prompting you to enter text.  In other cases there may
already be text in the edit boxes.  This text can be overwritten when you begin
typing.  To erase the text, use the backspace or the delete keys.  
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Menu and Dialog Controls

The following are descriptions of symbols and options you will encounter during the
inputting process.

Enabled/Disabled Options

Some commands in the pop-up menus or input controls in the dialog boxes are black
while others are grayed.  Commands that are black are available for use at that time.
Commands not available are gray and may become available depending on the data
you enter.  For example, in the Input menu, only Auto Input, Labels, and General
Information are black at the start of a new file.  When you have input information
in the General Information dialog box you will notice that the remainder of the
commands in the Input menu become black and are now ready for your input.

Radio Buttons

A radio button is used in a group of options from which you may select only one. A
group of radio buttons is a type of toggle (on/off) switch that when one radio button
is chosen, its state is toggled on and all other radio buttons are toggled off.  

For example, in the General Information dialog box you will see radio buttons in the
options you need to make a selection.  When using a mouse, place the cursor over
the option desired and click the left button once to toggle the switch on.  When using
the keyboard keys, tab to the group of options and choose one by using the up and
down arrow keys to toggle the switch.

Check Boxes

A check box is a toggle used in a dialog box that enables or disables an option.   To
enable a check box, toggle the switch so that an X is placed in the box.  Removing
the X from the check box disables the command.  

Click once in the check box with the mouse to enable or disable the command or use
the keyboard keys to tab to the check box and press the space bar to activate the
option.
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Push Buttons

Push Buttons are command buttons such as  Ok and  Cancel that are located
inside dialog boxes.  These are labeled to do exactly what they say.   After you have
completed your input within a dialog box, click once with the left mouse button on
Ok or press Alt +  O with the keyboard keys to save the changes.  If, while
working in a dialog box, you want to disregard the data you have input, select
Cancel to exit and discard any new data.  When using the keyboard keys select
Alt  +  C .

Working With Data Files

All of the commands required to save or open ADOSS data files are located in the
File menu.  This section will help you with the procedures of using the data files.

Creating a New Data File

When you first load ADOSS you will have a new file ready for input.  The data will
not have a filename associated with it, therefore, “Untitled” will appear in the title
bar. 

To start a new data file:

1. If you are already in the program and in an existing file, select New to
clear your screen and return you to the default settings.  If existing data
has been changed prior to executing the New command, ADOSS will ask
if you would like to save the data.

2. Selecting New invokes the Auto Input command.  This command guides
you through the inputting process by automatically displaying all the
dialog boxes necessary to design your floor system.  You may cancel the
Auto Input mode by selecting  Cancel from any dialog box.

3. After you enter data through the Input menu, use the Save As command
to give the file a name. 
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Saving Your Data

ADOSS has three commands for saving your data.  You may save your data in the
ADOSS format with the same filename or a new filename, or save the data in the
old ADOSS format.

In order to save the shear and moment diagrams as well as the deflected shapes of
the one-way slabs and continuous beam systems, you must save your data using the
Save command after you execute the Design System command.

To save your data with the same filename:

1. Select the Save command from the File menu.  If the data has not been
modified since the last Save or Save As command was executed, this
option will not be available. The file will be updated and the Save
command will be grayed.

To give your data a new filename:

1. If you have not saved your data yet, select the Save or Save As command
from the File menu, these commands will have the same effect.  If you
would like to save a data file that currently has a filename with a new
filename, select the Save As command.  The dialog box of Figure 4-2 will
appear.  When no filename has been given to the current data, the default
filename is UNTITLED.ADS and it is highlighted in the edit box.

2. Type a new name to overwrite the current name.

3. Press Save to exit the dialog box and save the data into the filename
specified.

Figure 4-2  The Save As dialog box
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To save your data in the old ADOSS format:

1. Select the Export command from the File menu.  The dialog box of
Figure 4-3 will appear.

2. Type a new name for the data file.

3. Press the  Export button.  At this point, if a file with the same name
exists, a message box will appear requesting if you would like to
overwrite that file.

4. Select the “ADOSS V4.X-V5.X Data” conversion utility from the list.

5. Press  Ok to save the data in the old ADOSS format.

Figure 4-3  The Export dialog box

Opening an Existing Data File

ADOSS allows you to open data files that were saved at an earlier time.  ADOSS
also allows you to open data files from a previous version of ADOSS.  

To open an existing data file:

1. Select Open from the File menu to bring in an existing ADOSS data file.
The dialog box of Figure 4-4 will be displayed.  All the files with an .ADS
extension contained in the current drive and directory will be displayed in
the list box. This dialog box also enables you to change the current drive
and directory.

2. Type in the name of the file you want to open.  You may also select a file
from the provided list with the mouse or using the keyboard by tabbing
to the list and using the up and down arrow keys.
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3. Press Open to exit the dialog box and allow ADOSS to read the data.
You may combine steps 2 and 3 of this procedure by double clicking the
left mouse button over the desired file from the provided list.

Figure 4-4  The Open dialog box

Modeling a Building Floor System

To model a building floor or a supported structural slab with ADOSS, lay out design
strips in one of two orthogonal directions (or lay out strips in the direction you want
to orient the flexural reinforcement).  Select unique sets of identical strips such as
exterior or interior strips.  The dimensions of each unique strip are entered into
ADOSS directly.  Other items such as floor system, (flat plate, flat slab, etc.),
concrete properties, and loadings must be pre-selected based on design
considerations.  Initial slab or beam dimensions must be based on rough hand
calculations or Code determined criteria.  After an initial run, optimizing the slab or
beam dimensions can be accomplished by simply adjusting the dimensions and
re-running the data.

Including Labels with the Output

To keep track of your output, ADOSS allows you to specify the name of the project,
span id, engineer, date, and time (date and time are automatically input when a new
data file is begun).  These labels will be printed with your output and are intended
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to help you organize your data.

To enter labels:

1. Select Labels from the Input menu.  The dialog box of Figure 4-5 will
appear.

2. Enter the Project ID, the identifying project title.

Figure 4-5  The Data Labels dialog box

3. Tab to the Span ID and enter the identifying span label.

4. Tab to the Engineer edit box and enter your name or the name of the
engineer who prepared the data.

5. Specify a new date and time or keep the default values.

6. Select  Ok to exit the dialog box and allow ADOSS to save these labels.

Creating the Floor System

The floor system is created by entering data through the Input menu.  You may select
the Auto Input command from the Input menu to automatically take you through the
required dialog boxes or you can follow the manual procedure given below.

To create the floor system:

1. Select the General Information command from the Input menu to define
the basic information.  Based on this information, the applicable
remaining commands in the Input menu will become available.

2. Enter the material properties by selecting the Material Properties
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command from the Input menu.

3. Enter the reinforcement information by selecting the Slabs and/or Beams
commands from the Input/Reinforcement menu.

4. Enter the floor system geometry from the commands located in the
Geometry menu.  Some of the member types may not be available,
depending on the floor system chosen in the General Information
command of step 1.

5. Finally, enter the loads on the system from the commands located in the
Input/Loads menu.

Using the General Information Command

The General Information command allows you to enter the number of spans, units,
code, structure type, frame location, lateral load types, loading pattern, and the
design option needed by ADOSS to proceed with the input process.  You must
choose this command before doing any further inputting since this command affects
the availability of the commands in the Input menu.

To enter general information:

1. Select the General Information command from the Input menu.  The
dialog box of Figure 4-6 will appear. 

Figure 4-6  The General Information dialog box
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2. Enter the Number of spans for your particular floor system.  The
minimum and maximum number of spans are 3 and 14 spans,
respectively.  Note that two cantilevers must be included in the number of
spans.  If an invalid number of spans is given, a message will inform you
of such when the  Ok button is pressed.

3. Select your unit of measurement.  US in-lb and SI Metric are the two
offered in ADOSS.  The SI Metric option also uses metric reinforcement.

4. Select the building standard you want your floor system to be designed
to:  ACI 318-95, CSA-A23.3-94.

5. Select the Design method. Strength reduction factors and load factors
are set by this option.  The ACI code allows Strength Design and
Alternate States Design whereas Limit States is the only option allowed
with CSA Standard CSA-A23.3-94.

6. Choose the Floor system type, you have six floor systems to choose
from.  This option affects the availability of the geometry commands in
the Input/Geometry menu described later in this chapter.  For example,
drop panel dimensions are required for flat slab and waffle slab systems,
whereas beam dimensions are required for beam-supported slabs and
continuous beam systems.  

7. The Frame location sets the default left slab width to either an interior
or exterior slab, depending on your selection.  

8. Next, select the type of Lateral loading present.  The default is none.
When Wind lateral loads are specified, the lateral loads are entered as
either concentrated Forces above and at the level of slab to be designed,
or Moments entered to the left, right, above, and below the joint.  This
option affects the availability of the lateral loads commands in the
Input/Loads menu described later in this chapter.

9. Choose the Loading pattern to be used by ADOSS for analysis and
design.  For vertical loads, the program selects the design requirements
for flexure and shear based on the following loading patterns:

Pattern 1 Full dead and 75% live on adjacent spans.

Pattern 2 Full dead and 75% live on alternate odd spans.

Pattern 3 Full dead and 75% live on alternate even spans.

Pattern 4 Full dead and live on all spans.
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When concentrated lateral loads are specified, or when moments due to
lateral loads are specified, the following additional loading patterns are
considered:

Pattern 5 Full dead and positive lateral.

Pattern 6 Full dead and negative lateral.

Pattern 7 Full dead, live, and positive lateral.

Pattern 8 Full dead, live, and negative lateral.

10. Lastly, when the box marked Proportion moments and shears is
checked, the moments and shears at a joint will be proportioned between
the slab and beams framing into the joint.  This option is not available for
one-way slabs or continuous beams and it has no effect if the transverse
beams do not exist in the other floor systems.  If you are using the
keyboard, use the space bar to insert or remove a check from this box.
(See “Shear Analysis of Slabs”, “Shear Analysis of Longitudinal Beams”,
and “Shear and Torsion Analysis of Transverse Beams” in Chapter 2 on
how this option affects the design results.)

11. Press  Ok to exit the dialog box and allow ADOSS to use the new data.

Defining the Material Properties

The Material Properties command from the Input menu allows you to input
material properties of the concrete and the reinforcement.  This command must be
executed in order to perform a design of the floor system.

Use the tab key to get to each edit box then type in your values, or use your mouse
and click directly on the desired box, then type in your values.  Refer to Chapter 2
“Material Properties” for a detailed explanation of the default values.

To define material properties:

1. Select the Material Properties command from the Input menu. The
dialog box of Figure 4-7 will appear.  

2. Enter the concrete Density for the following members: Slabs, Beams, and
Columns.  Entering a value for slabs will automatically display a value for
each of the other members.  The Type of concrete is automatically
determined from the values input for density. 
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Figure 4-7  The Material Properties dialog box

3. Enter the concrete compressive strength.  By entering a value for fć,
values for fct and fr will automatically be computed for the slabs, beams
and columns.

4. If you have values for the average split tensile strength of concrete, fct,
enter the values in the edit boxes for the slabs, beams, and columns.
These values will be used to compute modulus of rupture and
development lengths for concrete weight of densities lower than normal.
Default values are computed based on fć.

5. If you have values for the modulus of rupture, fr, enter the values in the
edit boxes for the slabs, beams, and columns.  Default values are computed
based on fct.  These values will be used for deflection analysis.  A large
value for fr will produce a deflection analysis based on gross, non-cracked,
sections.  The CSA A23.3-94 Standard requires that for the calculation of
slab deflections an fr value equal to 0.6 /2 be used.  ADOSS defaults to
this value of fr for the slab concrete in CSA design runs.

6. Enter the yield strength, fy, for slab and beam longitudinal reinforcement.

7. Enter the yield strength, fyv, for beam shear reinforcement.

8. Select whether the main reinforcement is epoxy-coated by clicking the
left mouse button on the box or tabbing to the box and pressing the space
bar.  This selection affects development lengths.

fc
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9. Press  Ok to exit the dialog box so that ADOSS will use these material
properties. 

When Alternate Design is selected, use fs for fy and fyv.

Defining Reinforcement Parameters

In order for ADOSS to select the reinforcement, you must define the slab and beam
reinforcement, bar sizes, location, and minimum spacing dimensions.  Depending
on the type of floor system you specified, either Slabs, Beams, or both of these
commands will be available to you.  (See “Area of Reinforcement” and
“Reinforcement Selection” for a discussion of the reinforcement computations.)

For both Slab and Beam dialog boxes, use the tab key to move to each input box or
use your mouse to click on an input box.

To define reinforcement:

1. Select either the Slabs or Beams command from the
Input/Reinforcement menu.  The dialog boxes of Figure 4-8 will appear.

2. For slabs and beams, enter the distance to the centroid of the reinforcing
from the tension face.  For the top reinforcement, this distance is from the
top of the slab to the centroid of the top bars; and for the bottom
reinforcement, this distance is from the bottom of the slab to the centroid
of the bottom bars, (see Figure 4-9).  The default value is 1.5 in. (40mm)
for both input items. 

3. Enter the Minimum bar size to start the iteration for determining
flexural reinforcement. 

4. Enter the Maximum bar size in beam design for beam-supported slab
and continuous beam systems only.  This number will be used as a stop
in the iteration for determining flexural bars in beams.  

5. Select whether the reinforcement is placed in the outer or inner layer.
This selection affects development lengths and will be grayed if any
code other than ACI 318-95 was selected in the General Information
dialog box.

6. Enter Minimum bar spacing for slab and beam flexural reinforcement.
This number should be based on aggregate size or detailing
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considerations.  Default spacing is 6 in. (150mm) for slabs, and 1 in.
(25mm) for beams.

7. Select whether Code minimum stirrups are provided for beam-supported
slabs and continuous beam systems.  This section requires that minimum
stirrups be provided over the entire length of the reinforcement
development.  This option affects the development length.

8. Press  Ok to exit the dialog box and allow ADOSS to use the new data.
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Defining the Structure Geometry

Select Geometry from the Input menu to enter slab, rib, longitudinal beam, column,
column capital, drop, and transverse beam geometry. Depending on the floor
system chosen in the General Information box, commands in the Geometry menu
may or may not be available.

The input method for these dialog boxes (except for ribs) differs from others you
have already encountered. 

Using the replace button:

When beginning a new file, ADOSS fills the geometry information with zeros.  In
order to modify the geometry, you must enter the data and replace the values.

1. Select the geometry command of the member type to modify, such as the
Slabs command, from the Input/Geometry menu.

2. Enter dimensions for the desired span or column.

3. For the program to accept your input, select Replace .  The updated data
will appear in the list box to the right.

4. Press  Ok   to exit the dialog box so that ADOSS will use the new data.

Using the copy from button:

Some dimensions may be the same for a member type.  Instead of typing the data
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over for each line use the Copy From command located in the lower half of the
dialog box.

1. Select the geometry command of the member type to copy, such as the
Slabs command, from the Input/Geometry menu.

2. Select the members to copy to.  When copying geometry, surface loads,
or column fixity data, multiple spans or columns can be selected.

Mouse selection:

Single Click Selects the item and removes the selection from all
other items.  This selection will also become the 
anchor for subsequent mouse actions.

Shift + Selects all items between the selection anchor, and 
Single Click removes the selection from items not in that range.

Control + Toggles the selection state of the selected item but
Single Click does not remove the selection from the other items.

This selection will also become the anchor for 
subsequent mouse actions.

Keyboard selection:

Shift + F8 Toggles the add mode state.  The add mode is
indicated by a flashing list box cursor.

Space bar If the add mode is disabled, the space bar is the same
as a single click of the mouse.  If the add mode is
enabled, the space bar is the same as Ctrl + a single 
click of the mouse.

Arrow keys If the add mode is disabled, these keys move the lis
box cursor as defined by the key.  This selection will 
also become the anchor for subsequent mouse 
actions.  If the add mode is enabled, these keys move 
the list box cursor as defined by the key but does not 
select the item, remove the selection from other items,
or move the selection anchor.

3. Select the Copy From button and enter the member number to copy
from.
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4. Press  Ok to exit the Copy From dialog box so that ADOSS will update
the list box. 

5. Press Ok to exit the dialog box so that ADOSS will use the new data.

Defining the Slab Geometry

The Slabs geometry command from the Input/Geometry menu is available for all
floor systems.  Span numbers are automatically sequenced from 1 to the number of
spans entered in the General Information box.  There are three different dialog boxes
for slab dimensions, the one displayed depends on the floor system chosen (see
Figure 4-10).  This dialog box will not have span length information if the system is
a continuous beam.  This command is optional for continuous beam systems.

To input slab geometry:

1. Select the Slabs command from the Input/Geometry menu.  One of the
dialog boxes of Figure 4-10 will appear.

2. Enter the span length from column centerline to column centerline or
edge to column centerline for the two cantilever spans (see Figure 4-11).
(Note: for continuous beam systems, the span lengths are input in the
Longitudinal Beam Geometry box and not in the Slab Geometry box.) If
there is no cantilever, half the column dimension should be entered as the
span length for cantilevers.  If the program detects a cantilever span
length less than one-half the column dimension in the direction of
analysis, c1, the cantilever length will be increased.  If a partial load is
affected by the span length l1, a message warns the user of this condition. 

3. Enter the slab thickness of the span.  For continuous beam systems where
the beam is a T-beam, this is the flange depth.

4. Enter the span design width in the transverse direction of analysis on the
left and right side of the column (see Figure 4-11).  These distances are
usually one-half the distance to the next transverse column or edge of the
slab for exterior spans.  The left and right designations are arbitrary.  Be
consistent.  Both interior and exterior spans may be used in a design strip.
Exterior sides are designated with the letter “E” input after the slab width
value, such as 2.5E.  This indicates an exterior width of 2.5 ft (m).  Also,
an exterior width will automatically be designated by ADOSS by entering
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a width value less than or equal to the transverse column dimension, c2.
To change an exterior width to an interior width, enter an “I” after the
width value.  Exterior sides do not contribute to the attached torsional
stiffness, although they do contribute to loading.  For T-beams, the width
left plus width right may be larger than the allowed flange width.  ADOSS
will use the total width entered for weight and superimposed loading but
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slab, and one-way slab systems

Figure 4-10b  The Slab Geometry dialog box for waffle slab systems
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will use code allowed dimensions for flange width and stiffness
computations.

5. Press the Replace button to update the slab geometry. 

6. Repeat steps 2 through 5 until all the spans have been updated.  You can
use the Copy From button as a short cut (see “Entering the Structure
Geometry” earlier in this chapter for help on the Copy From button).

7. Press  Ok to exit the dialog box and allow ADOSS to use the updated
slab geometry.

Defining the Rib Geometry

For the waffle slab system, you must define the rib geometry.  The ribs are assumed
to be the same throughout the strip.

To enter rib geometry:

For the rib dialog box, use the tab key to move to each edit box or use your mouse
to click on an edit box.

1. Select the Ribs command from the Input/Geometry menu.  The dialog
box of Figure 4-12 will appear.

2. Enter the spacing between ribs at the bottom for Clear rib spacing (see
Figure 4-13).
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3. Enter the width at the bottom for Rib width (see Figure 4-13).

4. Enter the depth of the rib below the slab for Rib depth (see Figure 4-13).

5. Press  Ok to exit the dialog box so that ADOSS can use the rib geometry.

Defining Longitudinal Beam Geometry

Longitudinal beam dimensions are required for the beam-supported slab and
continuous beam systems.  The span numbers are automatically sequenced from 1
to the number of spans.  There are two different dialog boxes, one for
beam-supported slab systems, and the other for continuous beam systems.  Note, the
span length for longitudinal beams are entered here for the continuous beam system.

To input geometry for beam-supported slab system:

1. Select the Longitudinal Beams command from the Input/Geometry menu.  The
dialog box of Figure 4-14 will appear.

2. Enter the width of the beam (see Figure 4-15).

3. Enter the depth of the beam from the top of the slab (see Figure 4-15).

4. Press the  Replace button to update the longitudinal beam geometry.
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5. Repeat steps 2 through 4 until all the beams have been updated.  You can use the
Copy From button as a short cut (see “Entering the Structure Geometry” earlier
in this chapter for help on the Copy From button).

6. Press  Ok to exit the dialog box so that ADOSS will use the new beam geometry.
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Figure 4-14  The Longitudinal Beam Geometry dialog box for beam-supported 
slab systems

Figure 4-15  Required longitudinal beam dimensions



To input geometry for continuous beam system:

1. Select the Longitudinal Beams command from the Input/Geometry
menu.  The dialog box of Figure 4-16 will appear.

2. Enter the span length from column centerline to column centerline or
edge to column centerline for the two cantilever spans.  If there is no
cantilever, half the column dimension should be entered as span length
for cantilever.  If the program detects a cantilever span length less than
one-half the column dimension in the direction of analysis, c1, the
cantilever length will be increased.  If a partial load is affected by the span
length, l1, a message warns the user of this condition. 

3. Enter the width of the beam (see Figure 4-15).

4. Enter the depth of the beam from the top of the slab at the left end, center,
and right end, respectively, if applicable (see Figure 4-17).  For a
prismatic beam, enter a value for the beam depth at the left end only.

5. Enter the length of the haunch at the left and right ends, respectively, from
the face of the column, if applicable (see Figure 4-17).  For a prismatic
beam, leave these values blank or zero.

6. Press the Replace button to update the longitudinal beam geometry.

7. Repeat steps 2 through 6 until the beams have been updated.  You can use
the Copy From button as a short cut (see “Entering the Structure
Geometry” earlier in this chapter for help on the Copy From button).

8. Press Ok to exit the dialog box so that ADOSS will use the new beam
geometry.
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Figure 4-16  The Longitudinal Beam Geometry dialog box for continuous beam-systems

Figure 4-17  Required haunched beam dimensions



Defining Column and Capital Geometry

Column data is optional, if no column is specified at the joint, the joint is assumed
hinged.  Column numbers are automatically sequenced from 1 to the number of
spans specified minus 1.  You will be allowed to enter in column dimensions above
and below.  

To input column/capital geometry:

1. Select the Columns/Capitals command from the Input/Geometry menu.
The dialog box of Figure 4-18 will appear.

Figure 4-18  The Column/Capital Geometry dialog box

2. Enter a value for c1, the column dimension in the direction of analysis
(see Figure 4-19). 

3. Enter a value for c2, the column dimension perpendicular to the direction
of analysis  (see Figure 4-19).  Round columns are specified with a zero
input for c1, c1 is then taken as the diameter.  Zero values for both column
dimensions will create a pin condition.
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Figure 4-19  Required column dimensions

4. Enter the column height above, the distance from the top of the design
floor to the top of the floor above (see Figure 4-19).  ADOSS obtains the
clear column height above by subtracting the average slab depth from the
height given.  Only the slab is considered for the floor system above.  A
zero dimension for the column heights above and below will create a >pin
condition.

5. Enter the column height below, the distance from the design floor to the
top of the floor below (see Figure 4-19).  To obtain a clear column height
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below, the slab/drop/beam depth is subtracted from the height given.
Only the slab is considered for the floor system below.  A zero dimension
for the column heights above and below will create a pin condition.

6. Enter the capital extension which is the distance from the edge of the
column to the end of the capital (see Figure 4-20).

7. Enter the capital depth which is the distance from the bottom of the soffit
(slab, drop, or beam), to the bottom of the capital.  The extension/depth
ratio must be less than or equal to 1.0 (see Figure 4-20).

Figure 4-20  Required capital dimensions

8. Press the Replace button to update the slab geometry. 

9. Repeat steps 2 through 8 until all the columns and capitals have been
updated.  You can use the  Copy From button as a short cut (see
“Entering the Structure Geometry” earlier in this chapter for help on the
Copy From button).

10. Press  Ok to exit the dialog box so that ADOSS will use the new data.
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Defining Drop Geometry

Drops are only available for the flat slab or waffle slab systems.  The drop numbers
are automatically sequenced from 1 to the number of columns.  The drop length and
width dimensions are computed by ADOSS, based on slab span dimensions, when
the check box marked “Standard Drop” is checked.

To input drop geometry

1. Select the Drops command from the Input/Geometry menu.  The dialog
box of Figure 4-21 will appear. 

2. Select whether ADOSS should compute the drop dimensions or the
dimensions will be user specified.  If ADOSS is to compute the
dimensions, the ”Standard drop” option should be checked and then only
the drop depth will be available.  When the “Standard drop” option is
selected ADOSS will calculate drop panel dimensions in accordance with
ACI 318-95 Clause 13.3.7.  Similar requirements contained in previous
editions of the CSA A23.3 Standard have been removed from the 1994
edition.  As a result the ACI minimum specifications for drop panels are
also used in CSA A23.3 runs when the “Standard Drops” option is
selected.  If you would like to specify drop dimensions other than those
computed by ADOSS, you must remove the check from the “Standard
Drop” option.  Using the mouse, click the left mouse button once on
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Figure 4-21  The Drop Geometry dialog box



Standard drop and the dimensions will become available.  Using the
keyboard, tab to Standard drop and press the space bar to remove the
check and the dimensions will become available.  

3. Enter the dimension in the direction of analysis from the column
centerline to the edge of the drop left of the column (see Figure 4-22).  If
this is a standard drop, this dimension will not be available and the length
left is set equal to the slab span length left/6 for interior columns or the
left cantilever length for the first column.

4. Enter the dimension in the direction of analysis from the column
centerline to the edge of the drop right of the column (see Figure 4-22).
If this is a standard drop, this dimension will not be available and the
length right is set equal to the slab span length right/6 for interior spans
or the right cantilever length for the last column.

Figure 4-22  The required drop dimensions

4-30 Operating the Program

ADOSS Graphics



5. Enter the width dimension in the transverse direction (see Figure 4-22).
If this is a standard drop, this dimension will not be available and the
width is set equal to slab width/3.

6. In order for ADOSS to recognize drops, drop depths are required for the
flat slab systems even if Standard Drop is checked.  Enter the depth of the
drop from the span with the smaller slab depth (see Figure 4-22).  For
waffle slab systems, the depth is automatically assumed to be equal to the
rib depth below the slab and is not displayed.  A value entered will be
considered to exist below the rib depth.

7. Press the Replace button to update the drop geometry. 

8. Repeat steps 2 through 7 until all the drop dimensions have been updated.
You can use the Copy From  button as a short cut (see “Entering the
Structure Geometry” earlier in this chapter for help on the Copy From
button).

9. Press  Ok to exit the dialog box so that ADOSS will use the new drop
geometry.

Defining Transverse Beam Geometry

The Transverse Beam command allows you to input the width, depth, and
eccentricity of transverse beams at each column.  The beams are automatically
sequenced from 1 to the number of columns.  This command is not available for the
continuous beam and one-way slab systems and it is optional for the remaining
systems.

To input transverse beam geometry:

1. Select Transverse Beams from the Input/Geometry menu.  The dialog
box of Figure 4-23 will appear.

2. Enter the width of the transverse beam (see Figure 2-24).

3. Enter the depth of the transverse beam which is taken from the top of the
slab to the bottom of the beam (see Figure 2-24).

4. Enter the eccentricity, which is measured from the joint centerline,
positive to the right, and negative to the left of the joint (see Figure 2-24).

5. Press the Replace button to update the transverse beam dimensions. 
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Figure 4-23  The Transverse Beam Geometry dialog box

Figure 4-24  Required transverse beam dimensions

6. Repeat steps 2 through 5 until all the beams have been updated.  You can
use the Copy From button as a short cut (see “Entering the Structure
Geometry” earlier in this chapter for help on the Copy From button).

7. Press  Ok to exit the dialog box so that ADOSS will use the new beam
geometry.
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Changing the Column Fixity

You can change the percent of the actual column stiffness used in the analysis at all
the joints.  When the fixity lies between zero and 100%, the joint stiffness
contribution by the column is multiplied by that percentage.   Zero fixity indicates
a pin support.  The shear stresses are computed using the actual dimensions.  For
end columns, a fixity greater than 100% sets the column stiffness equal to a large
number (E20), in effect creating a fully fixed joint.  This applies to end columns
only.  The default fixity used by ADOSS is 100%, (i.e., the actual column stiffness).

To change column fixity:

1. Select Column Fixity under the Input menu.  The dialog box of Figure
4-25 will appear.

2. Select the column whose fixity you would like to modify by clicking the
left mouse button on the column in the list box to the right, or enter the
column number in the “Column no.” edit box.  

3. Press the Replace button to update the column fixity. 

4. Repeat steps 2 through 3 until all the column fixity percentages have been
updated.  You can use the Copy From button as a short cut (see
“Entering the Structure Geometry” earlier in this chapter for help on the
Copy From button).

5. Press  Ok to exit the dialog box so that ADOSS can use the new data.

Figure 4-25  The Column Fixity Factors dialog box
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Specifying Loads on the Floor System

To complete your analysis of a floor system, you must specify the applied loads.
ADOSS computes the self weight of the floor system.  There are several types of
applied loads that may be entered, they are found in the Input/Loads menu.  Surface
loads are placed over the entire strip.  Partial loads consist of uniform or trapezoidal
loads, concentrated loads, and concentrated moments that may exist anywhere
within the span length.  Refer to Chapter 2 “Loading” for a detailed explanation of
the superimposed loading on the floor system.

Specifying Uniform Surface Loads

Surface loads are uniform loads acting over the entire strip.  These loads have units
of psf(kN-m2).  The method for inputting surface loads is the same as that used in
entering the geometry.

To input surface loads:

1. Select the Surface Loads command from the Input/Loads menu.  The
dialog box of Figure 4-26 will appear.

Figure 4-26  The Surface Loads dialog box

2. Enter the unfactored superimposed dead and live loads acting over the
entire area of the strip, positive surface loads act downward.  ADOSS
automatically computes the structure’s self-weight.

3. Press the Replace button to update the surface loads.  
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4. Repeat steps 2 and 3 until the loads have been updated.  You can use the
Copy From button as a short cut (see “Entering the Structure
Geometry” earlier in this chapter for help on the  Copy From button).

5. Press  Ok to exit the dialog box so that ADOSS will use the new data.

Specifying Partial Surface, Concentrated, and Moment Loads

You may enter uniform or trapezoidal loads that do not span from column centerline
to column centerline in the direction of analysis.  You may also specify concentrated
vertical loads and moments.  These loads are called partial loads and are input
through the Partial Dead and Partial Live loads command of the Loads menu.
Partial loads are assumed to act over the entire strip width.

To input partial dead and live loads:

1. Select the Partial Dead or Partial Live load command from the
Input/Loads menu.  The dialog box of Figure 4-27 will appear.

2. Enter the span number of the span that you would like to input the loads.

3. Choose either uniform, trapezoidal, concentrated loads, or moments from
the radio buttons by clicking the left mouse button on the choice or
tabbing to the buttons and using the up and down arrow keys.  Up to 100
dead and 100 live loads may be entered.

4. Tab through the edit boxes and define unfactored dead or live load values
and their locations.  Depending on the type of loading, some or all of the
edit boxes will be available.  Figure 4-28 shows the input required and the
following is a description of that input.

Wa For uniform loads, Wa is the uniform load in units of lbs/ft
(KN/m), positive Wa is downward.  For trapezoidal loads, Wa is
the weight at the left end in units of lbs/ft (KN/m), positive Wa is
downward.  For concentrated loads, Wa is the force in units of kips
(KN), positive Wa is downward, and for moments, Wa is the
moment in units of ft-kips (KN-m), positive Wa is clockwise.

Wb For trapezoidal loads, Wb is the weight at the right end in units of
lbs/ft (KN/m), positive Wbis downward.  For all the other partial
load types, Wb is not available.
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Figure 4-28  The required partial load data



La For uniform and trapezoidal loads, La is the distance where the
load begins from the centerline of the column at the left of the
span, in units of ft (m).  For concentrated loads and moments, La
is the distance where the load exists from the centerline of the
column at the left of the span in units of ft (m).

Lb For uniform and trapezoidal loads, Lb is the distance where the
load ends from the centerline of the column at the left of the span,
in units of ft (m).  For concentrated loads and moments, Lb is
unavailable.

Although your particular loading may not actually act over the entire transverse
width, all partial loading is converted internally by ADOSS to act over the full width
of the slab.  In the design direction, partial loads given as acting over less than 1/20
of the span length will be averaged over 1/20 by the program.

5. Select Insert  to define the partial load.

6. Repeat steps 2 through 5 until all the partial loads have been entered then press
Ok   to exit the dialog box so that ADOSS will use the new loads.

To change partial dead and live loads data:

1. Select the partial load you want to change from the list box to the right by
clicking the left mouse button on the load or tabbing to the list box and
using the arrow up and down keys.

2. Make your changes to the load by modifying the load type, the load
magnitude, and/or location.

3. Select Replace to replace the old data with the new data.

To delete partial dead and live loads data:

1. Select the partial load you want to delete from the list box to the right by
clicking the left mouse button on the load or tabbing to the list box and
using the arrow up and down keys.

2. Press the  Delete button.
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Specifying Lateral Loads

ADOSS will combine the gravity load analysis with a lateral load analysis.  Lateral
loads may be entered as forces at the design floor and the floor above, or entered as joint
moments depending on the type of lateral load selected in the General Information
dialog box.  When the lateral loads are input as forces, ADOSS will perform a portal
load analysis to obtain the joint moments.  This method is an approximate method and
uses the entire strip width and uncracked sections in the analysis which is not a
recommended approach.  A more accurate approach is to enter the lateral analysis
through joint moments.  These moments must be obtained by a frame analysis program
such as PCA-FRAME program.  Whichever method is used, the joint moments are
combined with the gravity load moments to produce load patterns 5 through 8.

To input lateral load forces:

1. After the geometry has been entered, select the General Information
command from the Input menu.

2. Select Wind from the Lateral Loads options.

3. Select Forces from the types of wind load options.

4. Select  Ok .

5. Select the Lateral Forces command from the Input/Loads menu.  The
dialog box of Figure 4-29 will appear.

Figure 4-29  The Lateral Forces dialog box

6. Enter the total of the lateral loads of the floors above the design floor in
the Pa edit box.

7. Enter the lateral load at the design floor in the Pb edit box.

8. Select  Ok to exit the dialog box so that ADOSS may use these lateral
forces.
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To input lateral load moments:

1. After the geometry has been entered, select the General Information
command from the Input menu.

2. Select Wind from the Lateral Loads option.

3. Select Moments from the types of wind loads options.

4. Select  Ok .

5. Select the Lateral Moments command from the Input/Loads menu.  The
dialog box of Figure 4-30 will appear.  The joint numbers are
automatically sequenced from 1 to the number of columns.

6. Enter the moments at the joint left, right, top, and bottom; positive
moments are clockwise.

7. Press the Replace button to update the joint moments.

8. Repeat steps 6 and 7 until all the joints have been updated.  You can use
the Copy From button as a short cut (see “Entering the Structure
Geometry” earlier in this chapter for help on the  Copy From ).

9. Press  Ok to exit the dialog box and allow ADOSS to use the updated
joint moments.

Figure 4-30  The Lateral Moment dialog box
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Changing the Live Load Reduction Factor

ADOSS uses 75% of the live load by default when considering patterned loading of
load patterns 1 through 3.  You may change this percentage.

To change the live load reduction factor:

1. Select the Factors command from the Input/Loads menu.  The dialog box
of Figure 4-31 will appear if the ACI code was selected in the General
Information dialog box.

2. Enter the percentage of the live load to be used in pattern loading.

3. Press Ok to exit the dialog box so that ADOSS may use the new
reduction factor.

Figure 4-31  The Load Factors dialog box
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Changing the Load Factors

ADOSS allows you to change the magnification factors applied to the loads.  The
default values depend on the code selected with the General Information command.

The default load factors for the ACI codes are:

U1 = 1.4D + 1.7L

U2 = .75(1.4D + 1.7L ± 1.7W)

U3 = .90D ± 1.3W

The default load factors for the CSA code are:

U1 = 1.25D + 1.5L

U2 = 1.25D + .7(1.5L ± 1.5W)

U3 = .85D ± 1.5W

To change load factors:

1. Select Factors from the Input/Load menu.  The dialog box of Figure 4-31
will appear if the ACI code was selected in the General Information
dialog box.

2. Use the tab key to jump from one load factor to the next and type in the
desired load factor.  Note that the dead and live load factors of the first
load case are linked to the dead and live load factors of the second load
case; therefore, different factors for the dead and live loads cannot be
input for the two cases.

3. Select  Ok when all the desired load factors have been modified to exit
the dialog box and allow ADOSS to use the new data.
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Applying More Lateral Load to the Column Strip

If lateral loads are applied to the strip of a two-way floor system, ADOSS, by
default, distributes the lateral forces to the column and middle strip using the same
factors computed for vertical loads.  ADOSS allows you to specify a portion of that
lateral load directly to the column strip.

To apply more lateral load to the column strip:

1. Select Factors from the Input/Loads menu.  The dialog box of Figure
4-31 will appear if the ACI code was selected in the General Information
dialog box.  Note that this option will only be available for flat plate, flat
slab, waffle slab, and beam-supported slab systems.

2. Select the option “to proportion lateral forces by assigning a percentage
to the column strip” from the radio buttons by clicking the left mouse
button over the option or tabbing to the buttons and using the up and
down arrow keys.

3. Enter a percentage of the lateral load to be applied directly to the column
strip.

4. Press  Ok to exit the dialog box so that ADOSS may use the new
percentage.

To use code vertical distribution factors:

1. Select Factors from the Input/Loads menu.  The dialog box of Figure
4-31 will appear if the ACI code was selected in the General Information
dialog box.  Note that this option will only be available for flat plate, flat
slab, waffle slab, and beam-supported slab systems.

2. Select the option “to proportion lateral forces by using the code vertical
distribution factors” from the radio buttons by clicking the left mouse
button over the option or tabbing to the buttons and using the up and
down arrow keys.

3. Press  Ok to exit the dialog box so that ADOSS may use the code
distribution factors.
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Viewing the Input Data

ADOSS allows you to modify the geometry and load windows so that you can
analyze your input data more closely.  This section provides procedures on
performing these functions.

Viewing the Floor System with the Scale

You may view the floor system with a scale in ft (m) along the left and top edge of
the view windows.  This allows you to check the structure dimensions or help in
determining the location of a zoom.

To turn the scale on:

1. Select the Scale On command from the View menu.  This command will
redraw the floor system in full size, place the scale on the top and left of
the window, and change the Scale On command to Scale Off. 

To turn the scale off:

1. Select the Scale Off command from the View menu.  This command will
redraw the floor system in full size, remove  the scale from the top and
left of the window, and change the Scale Off command to Scale On. 

Zooming in on the System

In order to view the floor system in greater detail, ADOSS allows you to magnify a
portion of the floor system for closer analysis. 

Using zoom with the mouse:

1. Select Zoom from the View menu.  Note that the cursor has changed to
a cross. 

2. Move the cross cursor to the upper left corner of the portion of the system
you want to enlarge.

3. Press and hold down the left mouse button while dragging the cursor to
the lower right portion of the system enclosing the desired area within the
dashed box.  Note the cursor has changed to an arrow.

4. Release the mouse to enlarge that portion.
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Using zoom with the keyboard:

1. Select the Zoom command from the View menu by pressing Alt  + V  ,
then type  Z  .  Note that the cursor has changed to a cross. 

2. Using the arrow keys, move the cross cursor to the upper left corner of
the portion of the system you want to enlarge.

3. Press the space bar once and use the arrow keys to enclose the desired
area within the dashed box.  Note the cursor has changed to an arrow.

4. Press the space bar once again to enlarge that portion.

If you have altered your screen view using the Zoom command, select Redraw from
the View menu to restore the figure to its original proportions.

Changing the Isometric View Angle

You can modify the X and Z angles at which the floor system is displayed in the
Isometric View window.  By default, the floor system is viewed at -45<198> about
the X axis and 45° about the Z.  The right hand rule is used to determine the angle
of rotation about the X and Z axes and the X axis is always rotated first.

To change angles:

1. Select Change Isometric Angle from the View menu.  The dialog box of
Figure 4-32 appears displaying the currently set angles.

2. Change the angles of rotation about the X and Z axes.  The X axis is
rotated first then the Z axis is rotated.  The floor system is rotated about
the axis using the right hand rule.

3. Select  Ok to accept the new angles and to modify the isometric view.

Figure 4-32  The Isometric View dialog box
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Viewing Specific Member Types

In order to see the floor system members in greater detail, you can select specific
member types to view by enabling and disabling them.

To select member types using the mouse:

1. Select the View Members command from the View menu.  The dialog
box of Figure 4-33 will appear showing the currently displayed member
types.  Depending on the floor system, some of the member types will be
grayed and unavailable.

2. To hide a member type from a view of the floor system you must remove
the X from the check box.  Click the left mouse button on the check box
of the member type you would like to hide.  To view a previously hidden
member type, click the left mouse button on the check box to add the X
to the check box.

3. Select  Ok to view only the selected member types.

To select member types using the keyboard:

1. Select the View Members command from the View menu.  The dialog
box of Figure 4-33 will appear showing the currently displayed member
types.  Depending on the floor system, some of the member types will be
grayed and unavailable.

Figure 4-33  The View Members dialog box
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2. To hide a member type from a view of the floor system you must remove
the X from the check box.  Tab to the member type you would like to hide
and press the space bar to remove the X.  To view a previously hidden
member type,  tab to the member type and press the space bar to add the
X to the check box.

3. Select Ok  to view only the selected member types.

Viewing Specific Load Types

In order to see the partial loads in greater detail, you can select specific load types
to view by enabling and disabling them.

To select load types using the mouse:

1. Select the View Loads command from the View menu.  The dialog box
of Figure 4-34 will appear showing the currently displayed load types. 

2. To hide a load type from the partial loads window you must remove the
X from the check box.  Click the left mouse button on the check box of
the load type you would like to hide.  To view a previously hidden load
type, click the left mouse button on the check box to add the X to the
check box.

3. Select  Ok to view only the selected load types.

Figure 4-34  The View Loads dialog box
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To select load types using the keyboard:

1. Select the View Loads command from the View menu.  The dialog box of
Figure 4-34 will appear showing the currently displayed load types. 

2. To hide a load type from the partial loads window you must remove the
X from the check box.  Tab to the load type you would like to hide and
press the space bar to remove the X.  To view a previously hidden load
type, tab to the member type and press the space bar to add the X to the
check box.

3. Select  Ok to view only the selected load types.

Designing

Once all the geometry, material, reinforcement, and load data have been input, you
can begin the design.  The commands in the Design menu are used for this purpose.

Condensing the Output

The Condense/Expand Output command under the Input menu allows suppression
of parts of the ADOSS output.  ADOSS will print those items that have a check in
the box.  You must perform the design after executing the Condense/Expand Output
command in order for ADOSS to print only the requested information.

To include or remove the desired output:

1. Select Condense/Expand Output from the Design menu.  The dialog
box of Figure 4-35 will appear.  Figure 4-35 shows the output sections
that will be printed by default. 

2. To remove or add a check, click the left mouse button on the box or tab
to the output item and press the space bar.  The following is a list of the
output options.
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Figure 4-35  The Condense/Expand Output dialog box

Input Echo An echo of the floor system input.  The first page of
the input, however, will always be printed whether 
this option is selected or not.

Column Service The column service level moments and axial force 
Load Table table.  This table is used for output to the PCACOL 

column design program.  The axial loads represent the
load of a single story only.  A column can still be 
designed with ADOSS if this option is turned off.

Centerline Factored moments and shears at the left, right, top, 
Moments and bottom of the centerline of the joint for each load 
and Shears case.

Segmental Factored moments and shears at the left and right ends 
Moments of the span and at the center of 20 equal segments 
and Shears within.  Shear and moment diagrams can still be 

viewed if this option is turned off.
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Segmental The maximum factored top and bottom moments and 
Envelopes shears as well as the governing pattern at the left and 

right ends of the span and at the center of 20 equal 
segments within.  Shear and moment envelope 
diagrams can still be viewed if this option is turned 
off.

Column Strip Column strip lateral distribution factors used to 
Distribution compute the column strip, middle strip, and beam 
Factors moments.

Design Moments Factored design moments at the column face and in 
the span.

Shear Table The punching shear calculations around the column 
and drop (if applicable) due to direct shear and with 
moment transfer.

Reinforcing Required reinforcement area based on the moments at 
Required the design location.

Reinforcement Number of bars, bar number, and bar lengths 
Bar Schedule required.

Development The basic development lengths including all the 
Lengths factors used to determine the final development 

length.

Additional Provided and required reinforcement, any additional 
Information reinforcement required at joint due to unbalanced 

moment and the total static design moments for each 
span.

Deflections I-effective for the dead load and service load 
short-time deflection of the column and middle strips 
for the dead, live, and total loads.  The live load 
deflection is computed as the difference between the 
total and dead load deflections.

Material Table of the approximate total and unit quantities of 
Quantities concrete, formwork and reinforcement. The
f o r m w o r k
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includes allowance for vertical sides of drops, beams, 
and so forth.  The reinforcement estimate is for one direction only and
ignores items such as hooks, bends, and waste.

3. Press  Ok to exit the dialog box and allow ADOSS to print only the
output portions requested.

Designing the Floor System

The Design System command starts the design portion of ADOSS after you have
finished inputting all the data.  If the PCACOL column design program is on the
system, a design of the concrete columns will be allowed.

To design the system:

1. Select the Design System command from the Design menu.  If any data
required to analyze and design the system has not been input prior to
executing this command, ADOSS will display a “Cannot design system,
need more data” message.  The dialog box of the required data will
appear.  Complete the data and select  Ok  .

In order to save the shear and moment diagrams or the deflected shapes with the
data file, you must save the data using the Save command after executing the Design
System command.

Designing the Column

Once the floor system has been designed, you can design the columns.  When
ADOSS is started, it searches the current directory, then all the directories of the
PATH for the PCACOL program.  If it is found, ADOSS makes this command
available.

The dimensions are taken from the specified column above or below.  The moments
at the column top are the same moments obtained from the ADOSS analysis joint
bottom moments.  The moments at the column bottom are the same moments
obtained from the ADOSS analysis joint top.  The moments passed to the PCACOL
program are therefore centerline moments and the axial force is the sum of the
shears left and right of the joint.  Therefore, PCACOL will design the column
section which frames into the joint at the specified column.
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To design the column using the mouse:

1. Bring the elevated view window to the top of the desktop by selecting
Elevated from the Window menu.

2. Double click the left mouse button on the desired column.  ADOSS
creates a PCACOL compatible data file and executes the PCACOL
program.

3. Once in the PCACOL program, enter any additional loads on the column,
then design the column using the methods found in the PCACOL manual.

To design the column using the keyboard:

1. Select the Design Column command from the Design menu.  The dialog
box of Figure 4-36 will appear.

2. Select the column number of the column to design.

Figure 4-36  The Design Column dialog box

3. Select the location of the column, above or below the design slab, to be
designed from the radio buttons by tabbing to the locations and using the
up and down arrow keys to select.

4. Press  Ok to exit the dialog box and to execute the PCACOL program.

5. Once in the PCACOL program, enter any additional loads on the column,
then design the column using the methods found in the PCACOL manual.
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Viewing and Printing Design Results

Once the analysis and design is performed, you can view and print the results, shear
and moment diagrams, and deflected shapes (deflected shapes of only the
continuous beam and one-way slab may be viewed).  This section provides
procedures on performing these functions.

Viewing and Printing the Results

After performing the design of the floor system, you are able to view and print the
design results.  ADOSS saves the design results into a file with the same name (i.e.,
the first part of a filename with a maximum length of 8 characters) of the ADOSS
data file and an extension of .OUT.  If the data has not been given a filename, the
design results filename will be UNTITLED.OUT.  

Selecting options in the Condense/Expand Output command from the Design menu
allows you to select portions of the results to be printed.  The Condense/Expand
Output command must be executed prior to the design.

To view the design results:

1. Select the View Results command from the View menu.  The PCA View
utility will be used to display the design results.  The PCA View window
will overlap the main window of the ADOSS program, displaying the
results file.

2. You can use the mouse or the cursor keys to scroll through the results.

3. Select the Exit command or press Alt + E to return to the ADOSS
program.

To print the analysis:

1. Select the Print Results command from the File menu to send the design
results to the printer.  A message box will be displayed informing you that
the file is being printed.  Press the  Cancel button only if you would like
to terminate the print job.
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Printing the Floor System Geometry

You may print the floor system geometry at any time.  The plan, elevated, and
isometric views will always be printed regardless of the number of view windows
opened.

To print the floor system geometry:

1. Select the Print Screen command from the File menu.  The dialog box of
Figure 4-37 will appear.  The view windows will be the default window
type to print.

2. Press  Ok  to print the floor geometry.

Figure 4-37  The Print Screen dialog box

Viewing and Printing Shear and Moment Diagrams

Once the design has been performed, you may view and print the shear and moment
diagrams for any span at any available loading pattern.  The shear and moment
window will be split in half horizontally; the shear diagram will occupy the upper
half  and the moment diagram will occupy the lower half where each diagram will
be scaled to fill the entire half of the window.  In order to save the shear and moment
diagram information with the data file, you must save the data using the Save
command after executing the Design System command.

To view shears and moments:

1. Select the View Shears/Moments command from the View menu.  The
dialog box of Figure 4-38 will appear.

2. Enter the span number in the dialog box displayed for which you would
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like to see the shear and moment diagrams.  If an invalid number is
specified an error message will inform you of it. 

3. Select from the radio buttons whether a specific load pattern or the shear
and moment envelopes should be displayed.

4. If the load pattern is to be displayed, enter the pattern number for which
you would like to see the shear and moment diagrams.  If an invalid
number is specified, an error message will inform you of it.

5. Press  Ok  .  A new window will display the specified shear and moment
diagram.  This new window’s title is now displayed as a command in the
Window menu.  Selecting the title will bring this shear and moment
diagram window to the front and make it the active window.

Figure 4-38  The Shear/Moment Diagram dialog box

To print shears and moments:

1. In order to print a shear and moment diagram, you must first view it using
the procedure above.

2. Select the Print Screen command from the File menu.  The dialog box of
Figure 4-37 will appear.

3. Select the Shear/Moment Diagrams option from the radio buttons.  The
Shear/Moment Diagrams option will be grayed if either the Design
System command has not been executed or no shear and moment
diagrams have been viewed.

4. Select the shear and moment diagram you would like to print from the
provided list located to the right of the radio button by clicking the mouse
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on the down arrow to select a window or press Shift + the down arrow
key until the desired window appears.

5. Press Print  to send the diagram to the printer.  You may change the
margins of the screen print by selecting the Page Layout command (see
“Changing the Margins of a Screen Print” later in this chapter).

Viewing and Printing the Deflected Shapes

Once the design has been performed, you may view the deflected shape of the
one-way slab and continuous beam systems.  This command will not be available for
the other floors systems. The dead, live, and total load deflections will be
superimposed in one graph.  The diagram will be scaled to fill the entire window.
In order to save the deflected shapes information with the data file, you must save
the data using the Save command after executing the Design System command.

To view deflected shapes:

1. Select the View Deflections command from the View menu.  The dialog
box of Figure 4-39 will appear.

2. Enter a span number in the dialog box displayed for which you would like
to see the deflected shape.  If an invalid span number is specified an error
message will inform you of it. 

3. Press  Ok  .  A new window will display the deflected shapes of the
specified span.  This new window’s title is now displayed as a command
in the Window menu.  Selecting the title from the Windows menu will
bring this deflection window to the front and make it the active window.

Figure 4-39  The Deflected Shape dialog box
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To print deflected shapes:

1. In order to print a deflected shape, you must first view it using the
procedure above.

2. Select the Print Screen command from the File menu.  The dialog box of
Figure 4-37 will appear.

3. Select the Deflection Diagrams option from the radio buttons.  The
Deflection Diagrams option will be grayed if either the Design System
command has not been executed, no deflection diagram has been viewed,
or the system is not a one-way slab or continuous beam.

4. Select the deflection diagram you would like to print from the provided
list located to the right of the radio button by clicking the mouse on the
down arrow to select a window or press Shift + the down arrow key
until the desired window appears.

5. Press  Print to send the diagram to the printer.  You may change the
margins of the screen print by selecting the Page Layout command (see
“Changing the Margins of a Screen Print” later in this chapter).

Customizing ADOSS

You can change the colors used by ADOSS as well as default units, code, data
directory, and margins used at startup.  These commands are located in the options
menu.  This section provides procedures on customizing ADOSS.

Changing the Background Color

You can change the background color of the view windows to either black or white.
The member colors will be reset to the default value for that particular background
color.  These changes are saved in the PCAPROGS.INI file and they become the
default settings when ADOSS is executed.

To change the background color:

1. Select the Background Color command from the Options menu.  The
dialog box for Figure 4-40 will appear.
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Figure 4-40  The Background Colors dialog box

2. Choose either black or white from the radio buttons by clicking the left
mouse button over the desired color or using the up and down arrow keys
to select a color.

3. Press Save to store the color and change the view windows’ background.

Changing the Member Colors

You can change the colors of the different member types.  You may only change the
member colors on a computer that supports color. There are eight colors to choose
from.  When the background color is changed, the member colors will be reset to the
default values for that particular background.  You may want to change the member
color after the background has been changed.  These changes are saved in the
PCAPROGS.INI file and they become the default settings when ADOSS is executed.

To change member colors using the mouse:

1. Select the Member Colors command from the Options menu.  The
dialog box of Figure 4-41 will appear.

2. Select the colors from the box to the left of the member type by clicking
the left mouse button on the down arrow to scroll through the selections,
then click on the desired color.

3. Press Save to store the member colors and redraw the floor system with
the new colors.

To change member colors using the keyboard:

1. Select the Member Colors command from the Options menu.  The
dialog box of Figure 4-41 will appear.

2. Press  Shift + the down arrow key until the desired color appears.

3. Select Save   to store the member colors and redraw the floor system
with the new colors.
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Figure 4-41  The Member Colors dialog box

Figure 4-42  The Set Load Colors dialog box

Changing the Load Colors

You can change the colors of the different load types. <MI> You may only change
the load colors on a computer that supports color.<D>  There are eight colors to
choose from.  These changes are saved in the PCAPROGS.INI file and they become
the default settings when ADOSS is executed.

To change load colors using the mouse:

1. Select the Load Colors command from the Options menu.  The dialog
box of Figure 4-42 will appear.
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2. Select the colors from the box to the left of the load type by clicking the
left mouse button on the down arrow to scroll through the selections, then
click on the desired color.

3. Press Save to store the load colors and redraw the partial loads with the
new colors.

To change load colors using the keyboard:

1. Select the Load Colors command from the Options menu.  The dialog box
of Figure 4-42 will appear.

2. Press Shift + the down arrow key until the desired color appears.

3. Select Save to store the load colors and redraw the partial loads with
the new colors.

Changing the Default Units and Code

You can change the default units and code that ADOSS uses when it starts a new
file.  The default settings were set during the installation process.  These changes are
saved in the PCAPROGS.INI file and they become the default settings when
ADOSS is executed.

To change the default units and code settings:

1. Select the Default Units/Code command from the Options menu.  The
dialog box of Figure 4-43 will appear.

2. Select the units and code that ADOSS will use as defaults from the radio
buttons.  These new values will be stored in the PCAPROGS.INI file.

3. Select Save   to store the new settings.

Figure 4-43  The Default Units/Code dialog box
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Changing the Default Data Directory

When ADOSS is executed, the files of the default data directory are displayed in the
Open dialog box when the Open command is executed.  You may change the default
data directory that ADOSS searches.  This directory is saved in the PCAPROGS.INI
file and it becomes the default setting when ADOSS is executed.

To change the default data directory:

1. Select the Default Data Directory command from the Options menu.
The dialog box of Figure 4-44 will appear.

2. Enter a new data directory in the edit box that is displayed.  Not entering
a directory will cause ADOSS to search the current directory on startup.

3. Select Save to store the values in the PCAPROGS.INI file.

Figure 4-44  The Default Data Directory dialog box

Changing the Margins of a Screen Print

You may set the margins of output obtained using the Print Screen command.  The
margins you select will be saved in the PCAPROGS.INI file and become the default
settings.  These changes are saved in the PCAPROGS.INI file and they become the
default settings when ADOSS is executed.

To set margins:

1. Select the Page Layout command from the Options menu.  The dialog
box of Figure 4-45 will appear.

2. Tab to each edit box and enter in new margins.  The left margin is the
distance from the left side of the page to where the drawing will begin.
The right margin is the distance from the right side of the page to where
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the drawing will end.  The top margin is the distance from the page top to
where the drawing will begin.  The bottom margin is the distance to the
page bottom to where the diagram will end.  These margins are always
entered in units of inches, despite the units setting in the General
Information command.

3. Select Save to store the new margins in the PCAPROG.INI file.

Figure 4-45  The Page Layout dialog box

Manipulating the Windows

After inputting the data for the floor system, you have three different ways to view
the model and two windows for displaying loads.  The Window menu enables you
to arrange all the windows and select different view settings for them.

You may view your floor system in a Plan View, Elevated View, and Isometric View.
The default view displayed at startup is the Plan View.  The other two views are
displayed as icons in the lower left hand corner of your screen.

The Plan View is a direct view of your system from above.  The X and Y angles are
0°.  The Elevated View displays your system from one side.  This view is equivalent
to an X axis angle of -90° and a Z axis angle of 0°.  The Isometric View is a three
dimensional view of your model where the default angle is -45° about the X axis
and 45° about the Z axis.  You may change this viewing angle by selecting Change
Isometric Angle in the View Menu.

The Surface Loads window gives a graphical representation of the surface loads
entered on all the spans and the Partial Loads window gives a graphical
representation of the partial loads on all the spans.

There may be more windows displayed for a particular floor system.  This depends
on the number of shear and moment diagrams or deflected shape windows created.
The following instructions apply to all the windows.
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To open a window using the mouse:

1. Select Restore from the window’s Control menu, or double click on the
icon of the window you would like to view.

To open a window using the keyboard:

1. Press the Alt + W to open the Window menu.

2. Press the down arrow key to highlight the window you want to open and
press Enter or press the number of the window you want to open.  If
there are more than nine windows open, the last command in the Window
menu will be More Windows.  When this command is selected, the
window must be chosen from a list box that will appear.

When you have many windows open on your screen they may overlap each other,
making it difficult to locate a particular window.  You can manipulate the windows
in the following ways.

1. Select Cascade so the windows become the same size and layer on top of
each other with the title bar of each visible.

2. Select Tile All Windows so that the screen divides into equal parts and
displays all the windows you have open.  

3. Select Tile View Windows so that the open view windows are arranged
on your screen without overlapping.  If all three view windows are open,
they will be arranged so that the Isometric View is a half page display and
Plan View and Elevated View each share the other half. 

Working with Windows

See “Working with Windows” in the Microsoft Windows manual for help on
resizing, moving, shrinking, enlarging, and closing windows.
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Getting On-Line Help

The Help menu includes commands that enable you to obtain help for the ADOSS
program.  

To obtain a list of all the help topics:

1. Select Index to get a list of all the available help topics.  The Index list is
a combination of the Commands and Procedures help screens.

To obtain a list of the commands:

1. Select Commands to obtain a list of all the menu items. 

To obtain a list of the procedures:

1. Select the Procedures command to obtain a list of important topics in
designing a floor system.

To obtain help within the help system using the mouse:

1. Click once on an underlined topic to obtain information about it.
Whenever available, these screens will advise you on where to find
additional information on a topic. 

To obtain help within the help system using the keyboard:

1. Use the tab key to select an underlined topic.  Use the down arrow key to
scroll through all the commands and make them accessible.

2. Press Enter on the underlined topic to obtain more information about
it.

To obtain definitions using the mouse:

1. You may obtain a definition of a word that is underlined with a dash by
holding down the left mouse button on the word. A definition of the word
will be displayed in a pop-up box.

2. Release the mouse button and the pop-up box will disappear.

To obtain definitions using the keyboard:

1. Use the tab key to highlight the dashed underlined words.  

2. Once the word is highlighted, press and hold down the Enter key.  A
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definition of the word will be displayed in a pop-up box.

3. Release the Enter key and the pop-up box will disappear.

Additional help features are available in the boxes located under the menu line.
Those available in the ADOSS program are:  Index, Back, and Search.  

To access the help index within the help system:

1. Click on the Index box to get to the Index help screen.  

To jump back to the previous help screen:

1. Click on the Back box to return to the previous help screen.  

To find help on a specific word or phrase:

1. Click on the Search box to help you locate information in two ways:
either scroll through a list of topics or type text in the Search For text box.

For additional instruction on getting on-line help, refer to the Using Help command
in the Help menu.
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Obtaining the ADOSS Version Number

The About box contains the copyright information, the version number of the
ADOSS program, your firm name, city, and state.

To obtain the version number:

1. Select the About ADOSS command from the Help menu.  The dialog box
of Figure 4-46 will appear.

2. Press  Ok to exit the dialog box.

Figure 4-46  The About ADOSS dialog box
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Chapter 5

Output Description

Output Elements

Depending on the floor system and the output options selected, the printed output
will contain a selection of the following items (see the illustrated examples in
Appendix C):

Title Sheet

General Information

Span and Column Data

Lateral Load and Output Information

Service Loads for PCACOL Slenderness Design

Statics Printout for Gravity Load Analysis

Statics Printout for Lateral Load Analysis

Distance to Inflection Points from Supports

Segmental Moments and Shears

Segmental Moment and Shear Envelopes

Design Moment Envelopes at Supports

Design Moment Envelopes in Span

Column Strip Lateral Distribution Factors at Supports

Column Strip Lateral Distribution Factors in Spans

Distribution of Design Moments at Supports

Distribution of Design Moments in Span

Shear Analysis

Beam Shear Requirements
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Transverse Beam – Shear and Torsion Requirements

Negative Reinforcement

Positive Reinforcement

Development Length in Tension at Supports

Development Length in Tension in Spans

Reinforcement Schedule

Additional Reinforcement Requirements at Supports

Additional Information for In-Span Conditions

Integrity Reinforcement (CSA Standard Only)

Deflection Analysis

Quantity Estimates

Most of the output prints in tabular form with resulting data grouped at columns or
spans.  The next section discusses output in further detail.

Program Version

The program version number appears at the top of each output page along with the
date, run time, and licensee’s name.

Description of Input Echo

The input echo refers to all the data used in the analysis.  ADOSS defaults common
data; all other data must be input.  Carefully check the data echo and compare it with
the intended design system.

The Title Sheet displays details of the program’s originating source and disclaimer.

General Information lists details of concrete, structure type, control parameters,
number of spans, slab thickness, and so forth.
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Span and Column Data lists the span lengths, applied loads, column sizes, drop
dimensions, slab widths, design strips, column strips, and middle strips used by the
program.

Note that the information printed out at this stage corresponds exclusively to the
user’s specified data.

Lateral Load and Output Information lists the output parameters and either
lateral loads or joint moments.

CODE Checks

Prior to analysis, ADOSS tests the input for the following additional Code
requirements:

•  required slab thickness 

•  drop panel dimensions 

•  column capital dimensions

ADOSS prints a message when an item fails to meet Code requirements or when an
item’s value has been adjusted by the program.  ADOSS does not check cantilever
thickness; these calculations must be done manually.

Analysis Elements

Service Loads for PCACOL Slenderness Design. This table displays service load
moments and shears due to Dead, Live, and Lateral (Latr.) for each load case.  The
moments at the column top are the service moments from the “Joint Moment Table”
at the joint bottom.  The moments at the column bottom are the service moments
from the “Joint Moment Table” at the joint top.  Therefore, these moments are
applied to the column sections that frame into the joints.  Note, these moments are
at the joint centerlines.  The axial loads represent the loading of a single floor only.
Any axial loads on the column from the floors above must be added to this story’s
axial loads.

Statics Printout for Gravity Load Analysis. This table lists the centerline
moments and shears corresponding to one or more gravity patterns 1 through 4.  The
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sign convention used in this printout is shown in Figure 5-1.  Take notice that the
printout corresponding to pattern 1 is based on the condition of live load acting on
adjacent spans.  Moments and shears for column 1 are based on the assumption of
live loads acting on spans 1 and 2; moments and shears for column 2 are based on
the assumption of live loads acting on spans 2 and 3, and so on.

Statics Printout for Gravity and Lateral Load Analysis. This output lists the
centerline moments and shears corresponding to gravity and lateral loads – patterns
5 through 8.  Note that lateral load effects are combined with vertical loads in
accordance with the patterns described in Chapter 2. 

Distance to Inflection Points from Supports. This chart specifies the inflection
points from the center of the support on both sides of each support for all the
loading patterns.

Figure 5-1  Sign convention adopted by ADOSS
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Segmental Output. This table displays moments and shears at 22 locations along
each span for each loading condition.  There are 20 values at the center of each
segment and one for each end of the span.  Positive moments produce tension at the
bottom and positive shears act upward.

Segmental Envelopes. Segmental moment and shear envelopes are computed both
from vertical only loading patterns 1 through 4 and also from total loading patterns
1 through 8 when lateral loads are applied.  This allows you to determine the effects
produced by vertical and lateral forces as compared to those produced by vertical
loads only.  Positive moments produce tension at the bottom and positive shears act
upward.

Design Moment Envelopes at Supports. This table displays the design moment
envelopes, the distances to the critical sections from the centerline of the support,
and the governing patterns, as well as the maximum inflection points from the
centerline of the support and the governing patterns for the full equivalent frame.
The total design moment envelopes are the moments produced by patterns 1 through
4 when no lateral loads are present, or patterns 1 through 8 when lateral loads are
present.  The vertical design moments will only be printed if lateral loads exist and
they are the moments produced by patterns 1 through 4.  The design moment
envelopes, producing tension at the top and bottom of the floor system, are given at
the left and right of the column.

Design Moment Envelopes in Spans. This table displays the design moment
envelopes, the distances to the critical sections from the left support, and the
governing patterns, as well as the maximum inflection points left and right of the
critical sections and the governing patterns for the full equivalent frame.  The total
design moment envelopes are the moments produced by patterns 1 through 4 when
no lateral loads are present, or patterns 1 through 8 when lateral loads are present.
The vertical design moments will only be printed if lateral loads exist and they are
the moments produced by patterns 1 through 4.  The design moment envelopes,
producing tension at the top and bottom of the floor system are given.

Column Strip Lateral Distribution Factors at Supports. This table displays the
l2/l1, a1, al2/l1, and bt values and ultimately the percentage of the design moment at
the supports to be distributed to the column strip, and the percentage of the column
strip design moment to be assigned to the beam, if applicable.  By default, this table
is not printed.  For a detailed discussion, see Chapter 2, “Design Moments”.
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Column Strip Lateral Distribution Factors in Spans. This table displays the l2/l1,
a1, and al2/l1, values and ultimately the percentage of the design moment in the
spans to be distributed to the column strip, and the percentage of the column strip
design moment to be assigned to the beam, if applicable.  By default, this table is
not printed.  For a detailed discussion, see Chapter 2, “Design Moments”.

Distribution of Design Moments at Supports. This table displays the full
equivalent frame strip width design moments as well as those distributed to the
column strip, middle strip and the beam, if applicable, producing both tension at the
bottom and the top.  The total design moment is printed (vertical plus lateral) along
with the difference between the total and vertical only load moments.  This
difference is that due to the effects of lateral loads.  The difference will be zero if
either no lateral loads exist on the floor system or the vertical load only case governs
the design at the critical section.  A percentage of the design moment to total
moment is supplied after each design moment.  As a default, design moments are
distributed according to the code specified factors.  Optionally, only moments
obtained from vertical loading may be distributed according to these code factors
while a greater percentage of the moment difference due to lateral forces may be
assigned to the column strip and longitudinal beam, if present.  Note that the
percentages printed may not reflect those lateral distribution factors computed using
the code.  For a detailed discussion, see Chapter 2, “Design Moments”.

Distribution of Design Moments in Spans. This table displays the full equivalent
frame strip width design moments as well as those distributed to the column strip,
middle strip, and the beam, if applicable, producing both tension at the bottom and
the top.  The total design moment is printed (vertical plus lateral) along with the
difference between the total and vertical only load moments.  This difference is that
due to the effects of lateral loads.  The difference will be zero if either no lateral
loads exist on the floor system or the vertical load only case governs the design at
the critical section.  A percentage of the design moment to total moment is supplied
after each design moment.  As a default, design moments are distributed according
to the code specified factors.  Optionally, only moments obtained from vertical
loading may be distributed according to these code factors while a greater
percentage of the moment difference due to lateral forces may be assigned to the
column strip and longitudinal beam, if present.  Note that these percentages may not
reflect those lateral distribution factors computed using the code. For a detailed
discussion, see Chapter 2, “Design Moments”.

Shear Analysis. The shear “around column” table displays the allowable shear
stress, reactions, punching shear stress around the columns or column capitals, and
lists two sets of punching shear calculations – direct shear alone and direct shear
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with moment transfer.  The calculation for moment transfer adjusts the unbalanced
moment to the centroid of the critical section.  The “shear transfer” is the
unbalanced moment multiplied by gv.  The shear “around drop/solid head” table
displays the reactions and the punching shear stress around the drop.  For a detailed
discussion, see Chapter 2, “Shear Analysis of Slabs”.

Note:  The Code1 reconstructs the design equations for shear in terms of shear forces
rather than shear stresses; however, ADOSS does not accommodate this change and
computes shear strength in units of stress, psi or MPa.  When shear stress is
exceeded, ADOSS will warn: *SHEAR STRESS EXCEEDED.”

Design Elements

Beam Shear Requirements. This output contains two forms of tables.  A short
form displays the span length area to stirrup space value at d from the column face
at both beam ends and at 0.175l1, 0375l2, 0.675l1, and 0.825l1.  A longer form (given
when segmental output is selected) lists spacings for stirrup sizes at every 20th of
the span, including at d.  The program calculates shear using each side of the beam
for each load pattern.  Only the load patterns that have the largest shear are used for
stirrup design.  For a detailed discussion, see Chapter 2, “Shear Analysis of
Longitudinal Beams”.

The beam-supported slab or continuous beam systems use the following types of
shear computations:  1) total shear at beam ends with full design width, but lacking
proportion, used for tributary area, and 2) proportioned shear based on slab beam
stiffnesses used with the 45° tributary method.  Chapter 2 explains the two
computation methods in further detail.  Both methods are user selectable.

Transverse Beam – Shear and Torsion Requirements. This two-table output
contains the Shear and Torsion requirements for each transverse beam (the beams
on the left and right transverse sides of each column).  The design tables include
design loads and capacities at d from the column transverse face, and the required
stirrup area to spacing for shear (Av/s), torsion (At/s), total (Atot/s), and additional
longitudinal bar area (Al).  The longitudinal area must be combined with the
transverse beams’ flexural area.  These tables serve as a design guide.  The notes at
the bottom of the tables describe further limitations.  For a detailed discussion, see
Chapter 2, “Shear and Torsion Analysis of Transverse Beams”.
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Negative Reinforcement. This table lists the corresponding design widths and
reinforcement based on the moments printed in the Distribution of Design Moments
at Supports table.  The table indicates the side which requires the maximum area of
reinforcement and prints either an “L” or an “R” to indicate which side of the
support contains the design moment.  The program checks the selected amount of
reinforcement against the minimum requirements of the Code.2 If a slab section
cannot be singly reinforced, the program will respond with “*****”.  In such cases,
the engineer should consider revising the slab thickness.  Only continuous beam
systems will be designed for compression reinforcement.  Note that if computations
indicate that a positive moment occurred at the support, a message will warn of this
condition, and the section must be designed manually. For a detailed discussion, see
Chapter 2, “Area of Reinforcement”.

Positive Reinforcement. This table lists the corresponding design widths and
reinforcement based on the moments printed in the Distribution of Design Moments
in Spans table.  The program checks the selected amount of reinforcement against
the minimum requirement of the Code.2 If a slab section cannot be singly
reinforced, the program will prompt with “*****”.  In such cases, the engineer
should consider revising the slab thickness.  Only continuous beam systems will be
designed for compression reinforcement.  Note that if computations indicate that a
negative moment occurred within the span, a message will warn of this condition,
and the section must be designed manually. For a detailed discussion, see Chapter
2, “Area of Reinforcement”.

Reinforcement Schedule. This schedule is intended as a guide for proper bar
placement.  ADOSS selects the bar size according to the slab thickness and maximum
spacing requirements of the Code.3 The program selects the bar lengths based on the
computed inflection points and the recommended minimums of the Code.4 For
continuous beam systems, bars are placed in single a layer (see Figure 2-27), provided
there is sufficient beam width.  Hooks and bends are not included in bar length
figures.  For a detailed discussion, see Chapter 2, “Reinforcement Selection”.

Development Lengths in Tension at Supports. Development lengths are only
computed for the top reinforcement of the column strips,  middle strips and beams, if
applicable, at supports.  General factors such as: layer location, lateral support provided
to beam reinforcement, light-weight concrete, yield strength, and epoxy-coated
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covering are printed at the top of the table.  Specific values such as basic development
length (LDB), concrete cover (CON/COV), bar clear spacing (CLEAR/SPAC), and
code case factor (CODE/CASE), as well as the remaining three modifying factors of
concrete cover and spacing (COV/SPA), top reinforcement (TOP/RFT) and excess of
reinforcement (EXC/RFT) are printed for long (LG) and short (SH) bars.  Note that the
last three factors correspond to factors 1, 4, and 6 as defined in Table 2.9. For a
detailed discussion, see Chapter 2, “Reinforcement Selection”.

Development Lengths in Tension in Spans. Development lengths are only
computed for the bottom reinforcement of the column strips,  middle strips and
beams, if applicable, in the spans.  General factors such as: layer location, lateral
support provided to beam reinforcement, light-weight concrete, yield strength, and
epoxy-coated covering are printed at the top of the table.  Specific values such as
basic development length (LDB), concrete cover (CON/COV), bar clear spacing
(CLEAR/SPAC), and code case factor (CODE/CASE), as well as the remaining
three modifying factors of concrete cover and spacing (COV/SPA), top
reinforcement (TOP/RFT), and excess of reinforcement (EXC/RFT) are printed for
long (LG) and short (SH) bars.  Note that the last three factors correspond to factors
1, 4, and 6 as defined in Table 2.9. For a detailed discussion, see Chapter 2,
“Reinforcement Selection”.

Additional Information at Supports. This table lists the maximum unbalanced
moment – fraction of unbalanced moment transferred by flexure, gf, the resulting
moment transferred by flexure, the corresponding pattern number, and the critical
selection width as per the Code.5 When additional reinforcement is required, it is
selected based on the bars size at the support.  For a detailed discussion, see Chapter
2, “Area of Reinforcement” and “Additional Reinforcement at Support”.

The first part of the output table compares the required reinforcement with the
provided reinforcement.  Note that the required amount of reinforcement is
extracted from the table “Negative Reinforcement” and does not include the
required area due to unbalanced moments.

Additional Information for In-Span Conditions lists the total static design
moment for each span based on the average widths and loads on the span as per the
Code.6 Partial loads are not taken into account.  This table also includes a
comparison of the required reinforcement and provided reinforcement for positive
reinforcement.
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Deflection Analysis lists the I-effective due to dead load and service load short-time
deflection of the column and middle strips for dead loads, live loads, and
summation.  The loaded span values determine the dead load deflections, while the
difference between the total deflection and full dead deflections equals the full live
load deflections.  Note that the deflection table should be used in conjunction with
the results obtained from the analysis of the perpendicular direction.  For a detailed
discussion, see Chapter 2, “Deflection Analysis”.

Quantity Estimates lists the approximate total and unit quantities of concrete,
formwork, and reinforcement.  The formwork includes allowance for vertical sides
of drops, beams, and so forth.  Note that the reinforcement estimate is for one
direction only and ignores items such as hooks, bends, and waste.  For a detailed
discussion, see Chapter 2, “Material Quantities”.
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Appendix A

Conversion Factors – U.S. to SI

To convert from To Multiply by

in. m (0.001 mm) 0.002 540

ft m 0.304 800

lb N (0.001 kN) 4.448 222

kips (1000 lbs) kN 4.448 222

plf (lb/ft) kN/m 0.014 593

psi (lb/in.2) MPa 0.006 895

ksi (kips/in.2) MPa 6.894 757

psf (lb/ft2) kN/m2 0.047 880

pcf (lb/ft3) kg/m3 16.018 460

ft-kips kN-m 1.355 818

kg N 9.806 650
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U.S. Bar Sizes

U.S. Diameter Cross Sectional Closest Metric 
Bar No. (in.) Area (in.2) Bar No.

3 0.375 0.11 N-10

4 0.500 0.20 N-10

5 0.625 0.31 N-15

6 0.750 0.44 N-20

7 0.875 0.60 N-20

8 1.000 0.79 N-25

9 1.128 1.00 N-30

10 1.270 1.27 N-35

11 1.410 1.56 N-35

14 1.693 2.25 N-45

18 2.257 4.00 N-55
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SI Bar Sizes

Metric No. Diameter Cross Sectional Closest U.S.
(mm) Area (mm2) Bar No.

N-10 11.3 100 4

N-15 16.0 200 5

N-20 19.5 300 6

N-25 25.2 500 8

N-30 29.9 700 9

N-35 35.7 1000 11

N-45 43.7 1500 14

N-55 56.4 2500 18

Appendix A A-3

ADOSS Graphics SI Bar Sizes



Appendix B

References

1. Kripanarayanan, K. M., Analysis and Design of Slab Systems, Computer
Program User’s Manual, Portland Cement Association, SR184D, 1979.

2. Lee, B. H., Analysis and Design of Flat Plates, Flat Slabs, Waffle Slabs, and
Continuous Frames, Portland Cement Association, 1972 (discontinued).

3. CRSI Handbook Based Upon the 1977 ACI Building Code and the 1980
Supplement, Concrete Reinforcing Steel Institute, Schaumburg, Illinois, 60195,
1982.

4. Sozen, M. A., and Siess, C. P., Reinforced Concrete Floor Slabs – Design
Methods: Their Evolution and Comparison, Journal of the American Concrete
Institute, Proceedings, V. 60, No. 8, August 1963, pp. 999-1028.

5. Hatcher, D. S., Sozen, M. A., and Siess, C. P., Test of a Reinforced Concrete Flat
Plate, Proceedings of the American Society of Civil Engineers, V. 91, No. ST5,
October 1965, pp. 205-231.

6. Guralnick, S. A., and LaFraugh, R. W., Laboratory Study of a Forty-Five-Foot
Square Flat Plate Structure, Journal of the American Concrete Institute,
Proceedings, V. 60, No. 9, September 1963, pp. 1107-1185.

7. Hatcher, D. S., Sozen, M. A., and Siess, C. P., Test of a Reinforced Concrete Flat
Slab, Proceedings of the American Society of Civil Engineers, V. 95, No. St6,
June 1969, pp. 1051-1072.

8. Jirsa, J. O., Sozen, M. A., and Siess, C. P., Test of a Flat Slab Reinforced with
Welded Wire Fabric, Proceedings of the American Society of Civil Engineers,
V. 92, No. ST3, June 1966, pp. 199-224.

9. Gamble, W. L., Sozen, M. A., and Siess, C. P., Test of a Two-Way Reinforced
Floor Slab, Proceedings of the American Society of Civil Engineers, V. 95, No.
ST6, June, 1969, pp. 1073-1096.

10. Vanderbilt, M. D., Sozen, M. A., and Siess, C. P., Test of a Modified Reinforced
Concrete Two-Way Slab, Proceedings of the American Society of Civil
Engineers, V. 95, No. ST6, June, 1969,  pp. 1097-1116.

Appendix B B-1



11. Shewmaker, R. E., Xanthakis, M., and Sozen, M. A., Very Small Scale
Reinforced Concrete Multi-Panel Flat Slabs, Civil Engineering Studies,
Structural Research Series No. 265, University of Illinois, June 1963, 171 pp.

12. Xanthakis, M., and Sozen, M. A., An Experimental Study of Limit Design in
Reinforced Concrete Flat Slabs, Civil Engineering Studies, Structural Research
Series No. 277, University of Illinois, December 1963, 159 pp.

13. Nichols, J. R., Statistical Limitations Upon the Steel Requirement in Reinforced
Concrete Flat Slab Floors, Transactions of the American Society of Civil
Engineers, V. 77, 1914, pp. 1670-1726.

14. Gamble, W. L., Sozen, M. A., and Siess, C. P., Measured and Theoretical
Bending Moments in Reinforced Concrete Floor Slabs, Civil Engineering
Studies, Structural Research Series No. 246, University of Illinois, June 1962,
322 pp.

15. Jirsa, J. O., Sozen, M. A., and Siess, C. P., Pattern Loadings on Reinforced
Concrete Floor Slabs, Proceedings of the American Society of Civil Engineers,
V. 95, No. ST6, June, 1969, pp. 1117-1137.

16. Corley, W. G., Sozen, M. A., and Siess, C. P., The Equivalent Frame Analysis
for Reinforced Concrete Slabs, Civil Engineering Studies, Structural Research
Series No. 218, University of Illinois, June, 1961, 166 pp.

17. Jirsa, J. O., Sozen, M. A., and Siess, C. P., The Effects of Pattern Loadings on
Reinforced Concrete Floor Slabs, Civil Engineering Studies Structural
Research Series No. 269, University of Illinois, July 1963, 145 pp.

18. Corley, W. G., and Jirsa, J. O., Equivalent Frame Analysis for Slab Design,
Journal of the American Concrete Institute, Proceedings, V. 67, No. 11,
November 1970, pp. 875-884.

19. T ABS84, Computers and Structures, Inc., Berkeley, California, 1984.

20. ICES STRUDL II, Engineering User’s Manual, Vols. 1 and 2, Department of
Civil Engineering, Massachusetts Institute of Technology, R68-91/92,
Cambridge, Massachusetts, 1968.

21. Hawkins, N. M., Shear Strength of Slabs with Moments Transferred to Columns,
Special Publication SP42-35, American Concrete Institute, Detroit, Michigan,
1974, pp. 817-846.

B-2 Appendix B

References ADOSS Graphics



22. ACI Committee 435, Subcommittee 7, Deflections of Continuous Concrete
Beams, Journal of the American Concrete Institute, Proceedings V. 70, No. 12,
December 1973, pp. 781-787.

23. Nilson, A. H., and Walters, D. B., Jr., Deflection of Two-Way Floor Systems by
the Equivalent Frame Method, Journal of the American Concrete Institute,
Proceedings, V. 72, No. 5, May, 1975,  pp. 210-218.

24. ACI Committee 435, State-of-the-Art Report, Deflection of Two-Way Floor
Systems, Special Publication SP43-3, American Concrete Institute, Detroit,
Michigan, 1974.

25. Kripanarayanan, K. M., and Branson, D. E., Short-Time Deflections of Flat
Plates, Flat Slabs and Two-Way Slabs, Journal of the American Concrete
Institute, Proceedings, V. 73, No. 12, December 1976, pp. 686-690.

26. Branson, D. E., Instantaneous and Time-Dependent Deflections of Simple and
Continuous Reinforced Concrete Beams, HPR Report No. 7, Pt. I, Alabama
Highway Department in Cooperation with U.S. Department of Commerce,
Bureau of Public Roads, August 1965.

27. Blakey, F. A., Deformations of an Experimental Lightweight Flat Plate
Structure, Commonwealth Scientific and Industrial Research Organization
(CSIRO), DBR Reprint No. 185, Civil Engineering Transactions, Institute of
Engineers, V. CE 3, No. 1,  Australia, March 1961.

28. Taylor, P. J., Long-Term Deflection Calculation Methods for Flat Plates,
Constructional Review, V. 43, No. 2, Sydney, Australia, May 1970, pp. 68-74.

29. Heiman, J. L., A Comparison of Measured and Calculated Deflections of
Flexural Members in Four Reinforced Concrete Buildings, Special Publication
JSP43-21, American Concrete Institute, Detroit, Michigan, 1974.

30. Rangan, B. V., Prediction of Long-Term Deflections of Flat Plates and Slabs<,
Journal of the American Concrete Institute, Proceedings, V. 73, No. 4, April
1976, pp. 223-226.

31. Notes on ACI318-83 – Building Code Requirements for Reinforced Concrete
with Design Applications, Portland Cement Association, 1984.

32. Elgabry, A. and Ghali, A., Proposed Revisions to Building Code Requirements
for Reinforced Concrete (ACI 318-83) (Revised 1986), ACI Structural Journal,
V. 86 No. 3, May-June 1989, pp. 327-328.

Appendix B B-3

ADOSS Graphics References



Appendix C

Examples

This appendix contains examples created using ADOSS V6.0.  There are no
instructions given with these examples, however, the dialog boxes used to create the
examples are given.  Refer to Chapter 4 for help on operating procedures.
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Example 1 Flat Slab

Analyze and design an interior strip shown in Figure C-1.

Figure C-1  Example flat slab problem
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Example 2, Beam- Supported Slab

Analyze and design an exterior strip shown in Figure C-2.

Figure C-2  Example beam-supported slab problem.
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Example 3, Continuous Beam

Analyze and design a continuos beam shown in Figure C-3.

Figure C-3  Example continuous beam problem
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Ribs,  4-21
Slabs,  4-18
Transverse Beams,  4-30

gf,  2-58
gv,  2-44

H

haunched beam,  4-23
height

column,  4-28
help,  4-66
Help menu,  3-11, 4-63

About ADOSS,  3-12, 4-65
Commands,  3-11, 4-63
Index,  3-11, 4-62
Procedures,  3-12, 4-63
Using Help,  3-12, 4-65

help system
Back,  4-64
Index,  4-64
Search,  4-64

I

Ie,  2-64 - 2-65
Iframe,  2-60
Ig,  2-65
Index,  3-11, 4-63 - 4-64
inflection points,  2-56, 5-4
input echo,  4-50, 5-2
Input menu,  3-4

Auto Input,  3-1, 3-4, 4-6, 4-10
Column Fixity,  3-5, 4-33
General Information,  3-4, 4-10-

4-11, 4-16, 4-39, 4-64
Labels,  3-4, 4-9
Material Properties,  3-4, 4-10, 

4-12
Insert button,  4-37
installing,  1-6 - 1-11
interior,  4-11, 4-21
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Is,  2-21, 2-32
Isb,  2-21
isometric view,  3-3, 3-6, 3-10, 4-44

changing angle,  4-44

J

Jc,  2-44

K

Kec,  2-22
Kt,  2-18, 2-21, 2-48
Kta,  2-21

L

l1,  2-28, 2-31, 2-46
l2,  2-21, 2-28, 2-33
Labels,  3-4, 4-9
lateral factors,  4-51
Lateral Forces,  4-38
lateral loads

portal analysis,  4-38
specifying,  4-12, 4-38

Lateral Moments,  4-39
layer,  4-16
lc,  2-15
length

drop,  4-31
haunch,  4-25
span,  4-19, 4-24 - 4-25

limit states,  4-11
Load Colors,  3-9, 4-59
loads

additional,  4-50

applied,  2-22
colors,  3-9
column service,  4-47
combination,  2-27
concentrated,  2-45
dead to live,  2-13
factors,  4-42
gravity,  5-4
hiding,  4-48
lateral,  2-23, 2-25, 2-33 - 2-34, 
2-45, 4-11, 4-39, 5-4, 5-6
moments,  4-35
partial,  2-23, 2-41, 2-59, 4-20 -

4-22, 4-34 - 4-39, 4-48
patterns,  2-15, 2-25, 3-7, 4-11, 

4-56
portal analysis,  4-38
reduction factor,  4-40
self-weight,  2-3 - 2-4, 2-22, 

2-41
specifying,  4-35 - 4-41
superimposed,  2-22
surface,  2-41, 4-18, 4-35
transverse beam,  2-47
trapezoidal,  4-36
uniform,  4-35

Loads menu,  3-5, 4-10, 4-11
Factors,  4-40, 4-43
Lateral Forces,  4-38
Lateral Moments,  4-38
Partial Loads,  4-36
Surface Loads,  4-34

location,  4-12
longitudinal beam

defining,  4-22
depth,  4-22 - 4-24
haunched,  4-24
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shear,  2-45 - 2-46, 5-7
width,  4-22 - 4-24

Longitudinal Beams,  4-18, 4-22 - 4-24

M

margins,  3-10, 4-57, 4-59
Material Properties,  2-10 - 2-11, 3-4, 

4-10
defining,  4-12

material quantities,  2-67, 4-49, 5-10
Maximize,  3-13
maximums

bar size,  4-14
bar spacing,  2-54

Mcr,  2-65
Member Colors,  3-9, 4-57
members

colors,  3-9, 4-57
hiding,  4-44
menu line,  4-2

menus
accessing,  4-2
closing,  4-3
commands,  4-3
Control,  3-12, 4-1, 4-63
Design,  3-8
File,  3-1, 4-5
Geometry,  3-5, 4-10, 4-11
Help,  3-11
Input,  3-4
Loads,  3-5, 4-10, 4-11
Options,  3-9
pop-up,  4-2
Reinforcement,  3-5, 4-10, 4-13
View ,  3-6

Window,  3-10, 4-53, 4-57 -
4-58, 4-62 - 4-63
message,  2-7 - 2-8, 2-52, 4-50
middle strip,  2-28, 2-31, 2-33 - 2-34, 

2-51
Minimize,  3-13
minimums

bar size,  2-54, 4-15
bar spacing,  2-54, 4-15

modeling,  4-9
modulus of elasticity

concrete,  2-11
reinforcement,  2-12

modulus of rupture,  2-12, 4-13
moment

beam,  2-33 - 2-34
centerline,  4-50
column,  4-53
column strip,  2-31
cracking,  2-65
design,  2-23, 2-31 - 2-33, 2-51, 

4-51, 5-5 - 5-6
diagram,  3-7, 3-10, 4-6, 4-54, 

4-54, 4-63
lateral analysis,  4-12, 4-38
middle strip,  2-33 - 2-34
negative,  2-51
printing,  4-55, 5-5
proportioned,  2-41, 2-43, 2-45, 

2-48
segmental,  4-50, 5-5
total static,  2-59
transfer,  2-59
unbalanced,  2-42

moment of inertia,  2-13
effective,  2-64 - 2-65
gross,  2-65
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More Windows,  4-65
Move,  3-12
Mu,  2-51, 2-58
Munbal,  2-42, 2-44, 2-48

N

New,  3-1, 4-5
Next,  3-13
number of spans,  4-10

O

one-way slab,  2-8, 2-64 - 2-65
Open,  3-1, 4-8, 4-63
optimize,  4-9
Option menu

Page Layout,  4-57
options

code,  1-8
default,  1-8
units,  1-8

Options menu,  3-9
Background Color,  3-9, 4-57
Default Data Directory,  1-9, 

3-10, 4-61
Default Units/Code,  1-8, 3-9, 

4-59
Load Colors,  3-9, 4-59
Member Colors,  3-9, 4-58
Page Layout,  3-10, 4-59, 4-64

output
condense,  4-47
expand,  4-47

P

Pa,  4-40
Page Layout,  3-10, 4-55, 4-59, 4-62
partial loads,  2-41, 2-59, 4-18, 4-20

changing,  4-35
deleting,  4-35
hiding,  4-46
inserting,  4-34
specifying,  4-34
PATH,  1-3, 3-8, 4-50

Pb,  4-40
PCA Programs,  1-10
PCA SETUP,  1-6
PCA View,  3-7, 4-52
PCACOL,  3-8, 4-52, 4-52, 5-3
PCAPROGS.INI,  1-8, 3-9, 4-59 - 4-61, 

4-62
pinned,  4-28 - 4-29, 4-34
plan view,  3-3, 3-10, 4-64 - 4-62
portal analysis,  2-23
print,  4-56, 4-58
Print Results,  3-3, 4-57
Print Screen,  3-3, 4-55
printing

deflections,  4-55
results,  4-52
shear and moment,  4-54

Procedures,  3-12, 4-63
project id,  4-9
proportioned moments and shears,  2-41,
2-43, 2-45, 2-48, 4-13
push buttons,  4-5
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Q

quantities,  2-67, 5-10

R

radio buttons,  4-4, 4-51
README,  1-10
Redraw,  3-6, 4-43
reduction factor,  4-39
references,  B-1
reinforcement

additional,  2-58, 4-49, 5-9
bend,  2-54
cover,  2-54
defining,  4-15
development length,  2-11, 4-13 

- 4-15, 5-9
distance to centroid,  4-15
epoxy-coated,  2-57, 4-13, 5-9
layer,  2-54, 4-16
maximum bar size,  4-13
maximum spacing,  2-54
metric,  4-11
minimum,  2-53
minimum bar size,  2-54, 4-13
minimum spacing,  2-53 - 2-54, 

4-15
negative,  5-8
positive,  5-8
quantity,  2-67, 5-10
required,  4-51
schedule,  2-59, 4-49, 5-8
yield strength,  2-46, 4-13

Reinforcement menu,  3-5, 4-10, 4-13
Beams,  4-10

Slabs,  4-10
Replace button,  4-16
requirements

hardware,  1-5
software,  1-5

Restore,  3-12, 4-65
results

printing,  4-52
viewing,  4-52

Revert,  3-3
ribs

clear spacing,  4-22
defining,  4-21
depth,  4-22
valid,  2-4, 2-40
width,  4-22

Ribs Geometry,  4-22
run,  1-11
running ADOSS,  1-11
rb,  2-52
rmin,  2-53

S

Save,  3-2, 4-6, 4-50, 4-54
Save As,  3-2, 4-6
Scale,  3-6, 4-42
Search,  4-64
segmental

envelopes,  5-5
moments,  4-50, 5-5

shears,  5-5
self-weight,  2-3 - 2-4, 2-22, 2-41, 4-34
shear

allowable,  2-39, 2-45
area,  2-35
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centerline,  4-48
column,  4-51
diagram,  3-3, 3-7, 3-10, 4-6, 

4-52, 4-65
direct,  4-51
longitudinal beam,  2-45 - 2-46, 

5-7
moment transfer,  2-35, 2-49
one-way,  2-34, 2-36
printing,  4-57, 5-7
proportioned,  2-41, 2-43, 2-45, 

2-48
punching,  2-34 - 2-35, 2-45, 

5-7
segmental,  4-50, 5-5
transverse beam,  2-47
wide beam,  2-34

shear/moment transfer,  2-34
shrinkage,  2-66
SI,  4-11
sign convention,  2-24
Size,  3-13
Slab Geometry,  4-18
Slab Reinforcement,  4-10, 4-14
slabs

defining,  4-18
thickness,  4-22

soffit,  2-1, 2-4
span

length,  4-18, 4-23
width,  4-22

span id,  4-10
split tensile strength,  2-11, 2-41, 4-13
standard drop,  4-29
stiffness,  2-13

beam,  2-4
capital,  2-4

column,  2-15
drop,  2-3
torsional,  2-15
waffle ,  2-9

stirrup,  2-46 - 2-47
STMFR II,  2-23
strength design,  4-11
strips

beam,  2-51
column,  2-28, 2-31, 2-33 -

2-34, 2-51
middle,  2-28, 2-31, 2-33 -

2-34, 2-51
surface loads,  2-41, 4-18, 4-33

specifying,  4-32

T

T-beam,  2-2, 2-4, 2-23, 2-52 - 2-53, 
4-21

Tc,  2-49 - 2-50
thickness

minimum,  2-6 - 2-7
slab,  2-52
waffle slab,  2-9

Tile All Windows,  3-11, 4-63
Tile View Windows,  3-11, 4-63
time,  4-10
title bar,  4-1
torque,  2-47 - 2-48
torsion
transverse beam,  2-47
transverse beam

defining,  4-31
depth,  4-31
eccentricity,  4-32
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shear,  2-47 - 2-50, 5-7
torsion,  2-47 - 2-50, 5-7
width,  4-30

Transverse Beams,  4-30
Tu,  2-48, 2-50
type,  4-14

U

units,  4-11
Untitled,  4-5
UNTITLED.ADS,  4-6
UNTITLED.OUT,  4-54
US,  4-11
Using Help,  3-12, 4-68

V

valid
drops,  2-2, 2-7
ribs,  2-4, 2-41

Vc,  2-11, 2-40 - 2-41, 2-46, 2-50
version,  4-68, 5-2
view

elevated,  3-3, 4-62
isometric,  3-3, 4-44, 4-64
plan,  3-3, 4-62

View Deflections,  3-8, 4-58
View Loads,  3-7, 4-48
View Members,  3-7, 4-47
View menu,  3-6

Change Isometric Angle,  3-6, 
4-44, 4-63

Redraw,  3-6, 4-46
Restore,  4-65
Scale,  3-6, 4-43

View Deflections,  3-8, 4-56
View Loads,  3-7, 4-46
View Members,  3-7, 4-46
View Results,  3-7, 4-54
View Shears/Moments,  3-7, 

4-54
Zoom,  3-6, 4-43

View Results,  3-7, 4-52
View Shears/Moments,  3-7, 4-54
viewing

deflections,  4-57
floor system,  4-42
results,  4-52
scale,  4-42
shears and moments,  4-54

views
elevated,  3-10, 4-53
isometric,  3-6, 3-10
plan,  3-10

Vu,  2-41, 2-43, 2-45 - 2-50

W

waffle slab,  2-2, 2-7, 2-34, 2-64 - 2-65,
4-22, 4-30, 4-32

ribs,  2-4
special considerations,  2-8 -

2-9
wbend,  2-54
width

drop,  4-32
effective slab,  2-58
longitudinal beam,  4-23
ribs,  4-22
span,  4-21
transverse beams,  4-31
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wind,  2-27, 4-12, 4-40
Window menu,  3-10, 4-52

Arrange Icons,  3-11
Cascade,  3-10, 4-63
More Windows,  4-65
Tile All Windows,  3-11, 4-62
Tile View Windows,  3-11, 4-62

windows
deflections,  3-3, 3-8, 3-10, 

4-55
elevated view,  3-3, 3-10, 4-51
isometric view,  3-3, 3-6, 3-10,

4-61
opening,  4-62
partial loads,  4-62
plan view,  3-3, 3-10, 4-61
shear and moment,  3-3, 3-7, 

3-10, 4-55
surface loads,  4-62
working with,  4-64

X

x,  2-21, 2-48
x1,  2-50

Y

y,  2-21, 2-48
y1,  2-50
yield strength,  4-14

Z

Zoom,  3-6, 4-45
zooming,  4-45
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